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1019: Project file extension cannot be .HLP or .PH 

1030: File name exceeds limit of 259 characters 

1079: Out of file handles 

1100: Cannot open file filename: permission denied 

1150: Cannot overwrite file filename 

1170: File filename is a directory 

1190: Cannot use reserved MS-DOS file filename 

1230: File filename not found 

1292: File filename is not a valid bitmap 

1319: Disk full 

1513: Bitmap name filename duplicated 

1536: Not enough memory to check and compress bitmap filename 

2010: Include statements nested more than 5 deep 

2030: Comment starting at line linenumber of file filename unclosed at end of file 

2050: Invalid #include statement 

2091: Bracket missing from section heading sectionname 

2111: Section heading missing 

2131: Invalid OPTIONS syntax: option=value' expected 

2141: Invalid ALIAS syntax: context=context' expected 

2151: Incomplete line in sectionname section 

2171: Unrecognized text 

2191: Section heading sectionname unrecognized 

2214: Line in .HPJ file exceeds length limit of 2047 characters 

2273: [OPTIONS] should precede [FILES] and [BITMAPS] for all options to take effect 

2291: Section sectionname previously defined 

2305: No valid files in [FILES] section 

2322: Context string [context_name] cannot be used as alias string 

2331: Context number already used in [MAP] section 

2341: Invalid or missing context string 

2351: Invalid context identification number 

2362: Context string [context_name] already assigned an alias 

2372: Alias string [aliasname] already assigned 

2391: Limit of 6 window definitions exceeded 

2401: Window maximization state must be 0 or 1 

2411: Invalid syntax in window color 

2421: Invalid window position 

2431: Missing quote in window caption 

2441: Window name windowname is too long 

2451: Window position value out of range 01023 



2461: Window name missing 

2471: Invalid syntax in [WINDOWS] section 

2481: Secondary window position required 

2491: Duplicate window name windowname 

2501: Window caption [windowcaption] exceeds limit of 50 characters 

2511: Unrecognized option optionname in [OPTIONS] section 

2532: Option optionname previously defined 

2550: Invalid path [pathname] in optionname option 

2570: Path in optionname option exceeds number of characters 

2591: Invalid MAPFONTSIZE option 

2612: Maximum of 5 font ranges exceeded 

2632: Current font range overlaps previously defined range 

2651: Font name exceeds limit of 20 characters 

2672: Unrecognized font name [fontname] in FORCEFONT option 

2691: Invalid MULTIKEY syntax 

2711: Maximum of 5 keyword tables exceeded 

2732: Character already used 

2752: Characters K' and k' cannot be used 

2771: REPORT option must be ON' or OFF' 

2811: OLDKEYHRASE option must be ON' or OFF' 

2832: COMPRESS option must be OFF', MEDIUM', or HIGH' 

2842: OPTCDROM option must be TRUE' or FALSE' 

2852: Invalid TITLE option 

2872: Invalid LANGUAGE option 

2893: Warning option must be 1, 2, or 3 

2911: Invalid icon file filename 

2932: Copyright string exceeds limit of 50 characters 

3011: Maximum of 32 build tags exceeded 

3031: Build tag length exceeds 32 characters 

3051: Build tag [tagname] contains invalid characters 

3076: [BUILDTAGS] section missing 

3096: Build expression too complex 

3116: Invalid build expression 

3133: Duplicate build tag in [BUILDTAGS] section 

3152: Build tag [tagname] not defined in [BUILDTAGS] section 

3178: Build expression missing from project file 

3511: Macro [macrostring] exceeds limit of 254 characters 

3532: Undefined function in macroname 

3552: Undefined variable in macro name 

3571: Wrong number of parameters to function in macro macro name 

3591: Syntax error in macro macro name 

3611: Function parameter type mismatch in macro macro name 

3631: Bad macro prototype 

3652: Empty macro string 

4011: Context string context name already used 

4031: Invalid context string context name 



4056: Unresolved context string specified in CONTENTS option 

4072: context sting exceeds limit of 255 characters 

4098: Context string(s) in [MAP] section are not defined in any topic 

4113: Unresolved jump or pop-up to context name 

4131: Hash conflict between context name and context name 

4151: Invalid secondary window name window name 

4171: Cannot use secondary window with pop-up 

4196: Jumps and lookups not verified 

4211: Footnote text exceeds limit of 1023 characters 

4231: Footnote text missing 

4251: Browse sequence not in first paragraph 

4272: Empty browse sequence string 

4292: Missing sequence number 

4312: Browse sequence already defined 

4331: Title not in first paragraph 

4352: Empty title string 

4372: Title defined more than once 

4393: Title exceeds limit of 128 characters 

4412: Keyword string exceeds limit of 255 characters 

4433: Empty keyword string 

4452: Keyword(s) defined without title 

4471: Build tag footnote not at beginning of topic 

4492: Build tag exceeds limit of 32 characters 

4551: Entry macro not in first paragraph 

4616: File filename is not a valid RTF topic file 

4639: Error in file filename at byte offset 0x%IX) 

4649: File filename contains more than 32767 topics 

4652: Table formatting too complex 

4662: Side-by-side paragraph formatting not supported 

4671: Table contains more than 32 columns 

4680: Font font name in file filename not in RTF font table 

4692: Unrecognized graphic format 

4733: Hidden page break 

4753: Hidden paragraph 

4763: Hidden carriage return 

4774: Paragraph exceeds limit of 64K 

4792: Nonscrolling region defined after scrolling region 

4813: Nonscrolling region crosses page boundary 

5035: File filename not created 

5059: Not enough memory to build Help file 

5075: Help Compiler corrupted. Please reinstall HC31.EXE. 

5098: Using old key-phrase table 

5115: Write failed 



HCPC

9001: Unrecognized footnote code 

9002: Embedded object text too long 

9003: Hotspot text too long 

9004: Invisible text too long 

9005: Hotspot text crosses paragraph boundary 

HCW

HC1000: Note: A keyword footnote has been specified without a keyword 

HC1001: Note: The keyword [ ] is already defined in this topic 

HC1002: Note: Using existing phrase table: [ ] 

HC1003: Note: A paragraph mark is formatted as a hidden character 

HC1004: Note: A previous instance of [ ] doesn't contain [ ] 

HC1005: Note: [ ] is not an unsigned number for the macro [ ]. The sign will be ignored. 

HC1006: Note: The ExecProgram macro has been used instead of ExecFile 

HC1007: The include tag [ ] has been specified in the [EXCLUDE] section 

HC1008: Note: Ignoring the transparent flag on the monochrome bitmap [ ] 

HC1009: Note: The map entry for [ ] has text after the number: [ ] 

HC1010: Note: The following mapped Topic IDs are not used in any topic: [ ] 

HC1011: Note: The right-justified table row style is not supported 

HC1012: Note: Table cell borders are not supported 

HC1013: Note: The "[ ]" section is missing a right bracket 

HC1014: Note: The multikey value [ ] has already been defined 

HC1015: Note: A page break is formatted as a hidden character 

HC1016: Note: A carriage return is formatted as a hidden character 

HC1017: Note: A nonscrolling region crosses a page break 

HC1019: Note: The Language option is obsolete. It should be replaced with the LCID option. 

HC1024: Note: The [ ] option has been specified more than once 

HC2002: Note: The keywords [ ] and [ ] differ only by case. The Help compiler has modified one keyword to match 
the other 

HC3000: Warning: The keyword [ ] is longer than [ ] characters 

HC3001: The file [ ] doesn't contain a valid icon 

HC3002: Warning: [ ] is a number but should be a string for the macro [ ] 

HC3003: Warning: The macro name [ ] is invalid. 

HC3004: Warning: The variable used in the macro [ ] doesn't match the macro's argument type. 

HC3005: Warning: The macro variable [ ] is undefined 

HC3006: Warning: Missing comma in authorable button command 

HC3007: Warning: [ ] is an invalid display-state parameter for the macro [ ] 

HC3008: Warning: Missing double quotation mark in macro [ ] 

HC3009: Warning: Missing end quotation mark (') in macro [ ] 

HC3010: Warning: The macro name [ ] is undefined 

HC3011: Warning: The accelerator [ ] has already been added 

HC3012: Warning: The macro [ ] doesn't include a window name 

HC3013: Error: [ ] is not a valid numeric parameter for the macro [ ] 



HC3014: Warning: Window name [ ] has already been used 

HC3015: Warning: This window position is invalid: [ ] 

HC3016: Warning: Invalid syntax for authorable button: [ ] 

HC3017: Warning: Topic ID for [ ] macro contains invalid characters: [ ] 

HC3018: Warning: In the project file, an #include statement is specified without a filename 

HC3019: Warning: Missing quotation mark or parenthesis in the macro [ ] 

HC3021: Warning: Cannot find the bitmap [ ] 

HC3022: Warning: The bitmap [ ] has already been used as a non-transparent bitmap 

HC3023: Warning: The bitmap [ ] has already been used as a transparent bitmap 

HC3024: Warning: The window name [ ] contains more than eight characters and has been truncated to [ ] 

HC3025: Warning: Jump to undefined Topic ID: [ ] 

HC3026: Warning: The Topic ID [ ] has already been defined in topic [ ] in file [ ] 

HC3027: Warning: The following alias line doesn't contain an '=' character separating the Topic IDs: [ ] 

HC3028: Warning: The bitmap file [ ] is corrupted 

HC3029: Warning: The file format of the bitmap file [ ] is unrecognized or unsupported 

HC3031: Warning: The Help compiler doesn't support compressed BMP files: [ ] 

HC3032: Warning: The bitmap file [ ] is truncated 

HC3033: Warning: The Topic ID [ ] contains invalid characters 

HC3034: Warning: Invalid parameter for TCard macro: [ ] 

HC3035: Warning: Map entry doesn't specify a numeric value: [ ] 

HC3037: Warning: The map value for [ ] is the same as the map value for [ ] 

HC3038: Warning: The following Topic IDs were not defined in the [MAP] section of the project file 

HC3041: Warning: The phrase file [ ] exceeds 64K. Phrase compression turned off. 

HC3042: Warning: The copyright string exceeds 255 characters. It has been truncated to the following: [ ]. 

HC3043: Warning: The title string exceeds 127 characters. It has been truncated to the following: [ ]. 

HC3044: Warning: Hotspot exceeds [ ] characters: [ ] 

HC3045: Warning: Footnote exceeds [ ] characters: [ ] 

HC3046: Warning: The [ ] file is not an RTF (Rich Text Format) file. It appears to have been saved as a Microsoft 
Word document 

HC3047: Warning: No name was specified for the bitmap command 

HC3048: Warning: Nonscrolling region is defined after scrolling region. 

HC3049: Warning: Invalid Topic IDs in hypergraphic: [ ] 

HC3050: Warning: Missing Topic IDs in hypergraphic: [ ] 

HC3051: Warning: Cannot jump to window [ ]. No windows have been defined in the project file. 

HC3052: Warning: The window name [ ] has not been defined in the project file. 

HC3053: Warning: The project file contains more than 255 window definitions 

HC3054: Warning: Build tag contains invalid characters. The following is invalid: [ ]. 

HC3055: Warning: The build tag [ ] has already been used 

HC3056: Warning: The window name [ ] in the macro [ ] contains more than eight characters and has been 
truncated to [ ] 

HC3057: Warning: A hotspot is defined with a macro (using !), but the macro is not specified 

HC3058: Warning: Topic ID for hotspot contains invalid characters: [ ] 

HC3059: Warning: A hotspot is specified without a macro or Topic ID 

HC3060: Warning: Window name is specified for a pop-up jump 

HC3062: Warning: Window definition is missing an '=' character: [ ] 

HC3063: Warning: Window definition doesn't contain anything after the '=' character: [ ] 



HC3064: Warning: Window name is not defined before the '=' character: [ ] 

HC3065: Warning: A closing quotation mark () is missing in window caption: [ ] 

HC3066: Warning: Window caption contains more than 50 characters: [ ] 

HC3067: Warning: The [ ] command in the [OPTIONS] section of the project file doesn't specify a value after the '=' 
character 

HC3068: Warning: The following line in the [OPTIONS] section of the project file doesn't contain an '=' character: 
[ ] 

HC3069: Warning: The [ ] option in the [OPTIONS] section of the project file is not recognized 

HC3070: Warning: the major browse string exceeds 50 characters: [ ] 

HC3071: Warning: One or more browse sequences are set, but browse buttons are not enabled in any window 

HC3072: Warning: The macro [ ] doesn't include a control panel name 

HC3073: Warning: No section is defined for the line: [ ] 

HC3074: Warning: The [ ] section is not recognized by this version of Help Workshop 

HC3075: Warning: The [ ] section doesn't follow the [OPTIONS] section in the project file 

HC3079: Warning: The alias string [ ] has already been aliased [ ] 

HC3080: Warning: The string [ ] has already been aliased [ ] 

HC3081: Warning: Both alias and Topic ID are identical: [ ] 

HC3082: Warning: The map number [ ] is not a valid number: [ ] 

HC3083: Warning: Invalid syntax for window color: [ ] 

HC3084: Warning: Invalid window syntax: [ ] 

HC3086: Warning: Window position is out of range: [ ] 

HC3087: Warning: The following filename exceeds 259 characters: [ ] 

HC3088: Warning: More than 20 font ranges are mapped 

HC3089: Warning: Invalid font range: [ ] 

HC3090: Warning: Current font range overlaps previously defined range: [ ] 

HC3091: Warning: Unrecognized forced font name: [ ] 

HC3092: Warning: This version of the project file is not supported by this The Help compiler 

HC3093: Warning: Keyword type is not a letter or number. [ ] is invalid 

HC3094: Warning: More than three keyword types (besides 'K' and 'A') defined 

HC3096: Warning: The font name [ ] is longer than 31 characters 

HC3097: Warning: The [BUILDTAGS] section is missing from the project file 

HC3098: Warning: Invalid build tag expression 

HC3099: Warning: Build expression too complex 

HC3100: Note: Build expression missing from file 

HC3101: Warning: Unknown build error 

HC3102: Warning: No macro is specified for the entry macro footnote 

HC3103: Warning: The entry macro footnote doesn't precede text 

HC3104: Warning: The Topic ID footnote (#) doesn't specify a Topic ID 

HC3105: Warning: The minor browse string exceeds 50 characters: [ ] 

HC3106: Warning: Browse footnote (+) doesn't appear before any text 

HC3107: Warning: A browse sequence has already been defined for this topic 

HC3108: Warning: The title footnote ($) doesn't appear before any text 

HC3109: Warning: The title footnote ($) doesn't contain any text 

HC3110: Warning: A title has already been defined for this topic 

HC3111: Warning: This topic contains keywords but no title 

HC3112: Warning: The build footnote (*) is not the first footnote in the topic 



HC3113: Warning: Build tag is longer than 32 characters: [ ] 

HC3114: Warning: The bitmap [ ] has been used as part of another {bmx} command 

HC3116: Warning: Table has more than [ ] columns 

HC3117: Warning: Side-by-side paragraphs are not supported 

HC3118: Warning: Unrecognized RTF (Rich Text Format) graphics format 

HC3119: Warning: Hash conflict between [ ] and [ ]. One of these Topic IDs must be changed. 

HC3120: Warning: The LANGUAGE option [ ] is not supported 

HC3121: Warning: Invalid version of Ftsrch.dll 

HC3123: Warning: Missing '=' character in REPLACE option: [ ] 

HC3124: Warning: The TMP folder [ ] is invalid 

HC3126: Warning: The window (>) footnote doesn't appear after the Topic ID (#) footnote 

HC4001: Warning: Cannot find or load Ftsrch.dll 

HC4002: Warning: The RTF file [ ] is corrupted at offset [ ] 

HC4003: Warning: An error occurred attempting to read the file [ ] 

HC4004: Warning: File is not an RTF (Rich Text Format) file 

HC4005: Warning: The [ ] Help file has not been created 

HC4006: Warning: The folder [ ] specified for the [ ] option doesn't exist 

HC4007: Warning: The [ ] option [ ] is not a valid value 

HC4008: Warning: Cannot find or load Ftsrch.dll. Hall compression turned off 

HC4009: Warning: The Topic ID specified in the project file as the default topic doesn't exist 

HC4010: Warning: There are more opening braces than closing braces 

HC4011: Warning: There are 20 opening braces without intervening closing braces 

HC4012: Warning: The full-text search index cannot be created because neither Phrase nor Hall compression has 
been selected 

HC4013: Warning: Invalid default font number in [ ]. Using [ ] as the default font 

HC4014: Warning: There is text after the closing brace in the RTF file 

HC5000: Error: The filename [ ] is too long 

HC5001: Error: File is a folder, not a file 

HC5002: Error: The text for the button in the CreateButton macro is too long 

HC5003: Error: Permission to open the file [ ] is denied. Another program has probably locked the file 

HC5005: Error: The file [ ] cannot be found 

HC5006: Error: Invalid RTF tokens for a table 

HC5007: Invalid use of the WinHelp menu [ ] in the [ ] macro. 

HC5009: Error: [ ] doesn't contain a comma separating the parameters in the macro [ ] 

HC5010: Error: [ ] is an invalid parameter for the macro [ ] 

HC5011: Error: Cannot open the file [ ] 

HC5012: Error: Too many nested #include files. Cannot include the file [ ] 

HC5013: Error: Invalid DBCS escape sequence: [ ] 

HC6000: Error: The Help compiler is out of memory. If you have any other programs running, close them and try 
compiling again 

HC6001: Error: Out of disk space writing to the temporary file [ ]. Free up disk space on this drive or change your 
TMP enviro 

HC6002: Error: An error occurred while reading the file [ ] 

HC6003: Error: Out of file handles. Increase the FILES= line in CONFIG.SYS 

HC6004: Error: The file [ ] is a read-only fil 

HC6005: Error: [ ] is a folder, not a file 

HC6006: Error: [ ] is a device name and cannot be used as a filename 



HC6007: Error: Cannot write to the file [ ] 

HC6008: Error: No files have been specified in the [FILES] section of the project file 

HC6009: Error: The language identifier [ ] is not supported in this version of Windows 



 HC1000: Note: A keyword footnote has been specified without a keyword

Problem

There is a keyword footnote (K), but there are no keywords listed for this topic. (There are no characters in the 
keyword footnote in the topic (.RTF) files.)

Result

The Help compiler ignores the keyword footnote. If there are no additional keyword footnotes, the topic will be 
inaccessible from the Index tab in the Help Topics dialog box.

Solution

Add one or more keywords to the topic and then recompile.



 HC1001: Note: The keyword [ ] is already defined in this topic

Problem

The same keyword has been defined more than once in a topic.

Result

The Help compiler ignores the duplicate keyword.

Solution

Remove the duplicate keyword:

1 From RoboHELP Explorer's Topic List, right-click on the topic and select Properties.
-or-
From Word, right-click anywhere in the topic and select Topic Properties.

2 Click the Index tab.

3 Select the duplicate keyword and click Remove.

4 Click OK.



 HC1002: Note: Using existing phrase table: [ ]

Problem

The Help compiler found an existing phrase (.PH) table for the Help file you are building, and the project (.HPJ) file 
doesn’t specify not to use the table.

Result

The Help compiler uses the phrase table that was generated from an earlier build instead of creating a new table.

Solution

To achieve the best phrase compression when compiling your Help file, you must delete the old key-phrase table:

1 From RoboHELP Explorer's File menu, select Project Settings.
-or-
From Word's RoboHELP menu, select Project Settings.

2 Click the Compile tab. 

3 Under Compression, clear the Reuse Phrase File (faster) option. (This option is only available if either the 
Phrase or Zeck and Phrase compression options are selected.)

4 Click OK.



 HC1003: Note: A paragraph mark is formatted as a hidden character

Problem 

A paragraph mark has been formatted as hidden text. This often occurs when a hotspot is the last word in a 
paragraph.

Result 

The Help compiler ignores the paragraph mark, so the two paragraphs will run together.

Solution 

Reformat the paragraph marker as plain text in the topic file and then recompile.



 HC1004: Note: A previous instance of [ ] doesn’t contain [ ]

Problem 

A {bmx} command specifying only one resolution version of a bitmap is followed later in the topic files by a {bmx} 
command specifying that version plus one or more additional versions.

Result 

WinHelp treats the earlier single-resolution command as if it were the same as the command specifying multiple 
resolutions.

Solution 

Replace the single resolution command with a copy of the multiple-resolution command.



 HC1005: Note: [ ] is not an unsigned number for the macro [ ]. The sign will be 
ignored.

Problem 

The parameter for this macro should be unsigned, but the number has been prefixed with a minus character.

Result 

The Help compiler removes the minus sign when it creates the Help file.

Solution 

Remove the minus sign from the macro definition and then recompile.



 HC1006: Note: The ExecProgram macro has been used instead of ExecFile

Problem 

The ExecProgram macro has been used.

Result 

The ExecProgram macro ignores the restricted programs that can be set in Windows 95. It doesn’t search the 
registry from programs, so some programs cannot be launched using this command.

Solution 

Replace instances of ExecProgram macro commands with ExecFile macro commands and then recompile.



 HC1007: The include tag [ ] has been specified in the [EXCLUDE] section

Problem 

You specified the same tag in the [EXCLUDE] section as in the [INCLUDE] section.

Result 

The Help compiler ignores the tag in the [EXCLUDE] section.

Solution 

Remove the tag from either the [EXCLUDE] or the [INCLUDE] section.



 HC1008: Note: Ignoring the transparent flag on the monochrome bitmap [ ]

Problem 

You’ve specified the Transparent option for a monochrome bitmap. You can only use the Transparent option with 
a 16-color bitmap.

Result 

The Help compiler ignores the Transparent option.

Solution 

Clear the Transparent option from the bitmap:

1 Go to the topic containing the monochrome bitmap.

2 Right-click on the bitmap and select Properties. The Help Image Properties dialog appears.

3 Clear the Transparent check box.

4 Click OK.

5 Recompile the Help file.



 HC1009: Note: The map entry for [ ] has text after the number: [ ]

Problem 

Text occurs after the numeric value specified in a map entry.

Result 

The Help compiler ignores the text following the number in the entry.

Solution 

Check the Map file (.HH) to make sure the map entry is correctly entered. (Comments must be preceded by a 
semicolon.) Recompile after making any changes to the Map file. 

Note: If the Help author is providing the Map files to the Programmer, use RoboHELP to generate the Map files. If 
you do, you won’t get Map file notes, warnings, or errors.



 HC1010: Note: The following mapped topic IDs are not used in any topic: [ ]

Problem 

Entries appear in the [MAP] section for which you have no topics.

Result 

If a program tries to use these mapped IDs, WinHelp displays an error message.

Solution 

There are two possible scenarios:

The Map IDs have become obsolete. Check with your Programmer to be sure these Map IDs aren’t needed. If this 
is the case, use the Remove Unused Map IDs option from RoboHELP Explorer's Tools menu to remove them. 
You can also alias these Map IDs. 

There are new Map IDs in the Help project. Create a new topic for each new, unused Map ID. 

Note: If the Help author is providing the Map files to the Programmer, use RoboHELP to generate the Map files. If 
you do, you won’t get Map file notes, warnings, or errors.



 HC1011: Note: The right-justified table row style is not supported

Problem 

A table style (right-justified table row) has been specified that WinHelp doesn’t support.

Result 

The Help compiler ignores the style.

Solution 

Remove the right-justified style from the table and recompile.



 HC1012: Note: Table cell borders are not supported

Problem 

A table format has been specified that WinHelp doesn’t support.

Result 

The Help compiler ignores the borders on the table. 

Solution 

You have three options:

· Ignore the note. The appearance of the Help text isn’t affected.

· Remove the cell borders from the table and recompile.

· Create a bitmap from the table. If the table fits on the screen, do a screen shot and save it as a bitmap. Insert 
the table bitmap into the topic and recompile.

Tip:

Consult RoboHELP's online Help for tips on how to create tables for WinHelp systems.



 HC1013: Note: The "[ ]" section is missing a right bracket

Problem 

A section in your Help project file (.HPJ) begins with a left bracket but doesn’t end with a right bracket.

Result 

The Help compiler ignores the section heading on this line. The following lines will be processed as if they are part 
of the previous section in the HPJ file, which may result in errors.

Solution 

Insert the right section heading bracket or remove the line entirely. Then recompile.



 HC1014: Note: The multikey value [ ] has already been defined

Problem 

A character used for indicating an alternate keyword table has been already used.

Result 

The Help compiler ignores the duplicate keyword table assignment on this line in the Help project file (.HPJ).

Solution 

Remove the duplicate character and then recompile.



 HC1015: Note: A page break is formatted as a hidden character

Problem 

A page break has been formatted as hidden text.

Result 

The Help compiler ignores the page break. If the page break was used to separate two topics, the topics appear 
as one topic.

Solution 

Reformat the page break in the topic file as plain text and then recompile.



 HC1016: Note: A carriage return is formatted as a hidden character

Problem 

A carriage return has been formatted as hidden text.

Result 

The Help compiler ignores the carriage return and doesn’t create a new line.

Solution 

Reformat the carriage return in the topic file as plain text and then recompile.



 HC1017: Note: A nonscrolling region crosses a page break

Problem 

The Keep With Next paragraph formatting used for specifying a non-scrolling region crosses a page break 
boundary.

Result 

The topic beginning with the page break will have a non-scrolling region, whether or not one is intended.

Solution 

Select the entire topic – including the page break for the next topic – and remove the Keep With Next paragraph 
formatting. If you intended to have a non-scrolling region for the topic, select only the topic title, and from the 
RoboHELP menu select Set Non-Scrolling Region. Recompile the Help file.



 HC1019: Note: The Language option is obsolete. It should be replaced with the 
LCID option.

Problem 

The LANGUAGE option has been used. This option has been made obsolete by the LCID option which should be 
used instead.

Result 

The Help compiler will attempt to convert the LANGUAGE option into an appropriate LCID option.

Solution 

In The Help compiler, open the project file. The Help compiler will automatically remove the LANGUAGE option 
and replace it with an LCID option.



 HC1024: Note: The [ ] option has been specified more than once

Problem 

The same option has been specified more than once.

Result 

The Help compiler uses the last definition for the option and ignores the others.

Solution 

Remove duplicate option entries from the project file and then recompile.



 HC2002: Note: The keywords [ ] and [ ] differ only by case. The Help compiler 
has modified one keyword to match the other

Problem 

Two keywords are identical except for case.

Result 

The Help compiler automatically changes the case of one of the keywords to agree with that of another otherwise 
identical keyword. For example: The uppercase letters in the keyword "MyKeyword" may be changed to lowercase 
letters in order to agree with the keyword, "mykeyword."

Solution 

Change the keywords so that all instances use the same case and then recompile.



 HC3000: Warning: The keyword [ ] is longer than [ ] characters

Problem 

Keywords can only be 255 characters. A keyword in the Help project exceeds this limit. 

Result 

The Help compiler ignores the keyword.

Solution 

Shorten the keyword or check the keyword at the topic level on the Topic Properties: Index tab or in the topic 
footnotes for a missing semicolon. (Multiple keywords for a topic must be separated by a semicolon in the topic 
footnotes.) Once you’ve corrected the problem, recompile the Help file.



 HC3001: The file [ ] doesn’t contain a valid icon

Problem 

You have specified an icon using the ICON option in the [OPTIONS] section of your project file. But the file doesn’t 
contain a valid icon image.

Result 

The Help compiler ignores the icon.

Solution 

Since WinHelp 4.0 doesn't use the icon anyway, simply remove the ICON option from your project file and 
recompile. (Open the Help project file .HPJ in Windows Notepad and remove the ICON option.)



 HC3002: Warning: [ ] is a number but should be a string for the macro [ ]

Problem 

The parameter for the macro should be a string, but it starts with a numeric character.

Result 

The Help compiler ignores the rest of the macro. WinHelp can’t run the macro in the compiled Help file.

Solution 

Use the Macro Editor Wizard to select the appropriate macro. If the macro’s parameter string really does begin 
with a number, place the string in quotation marks (`').



 HC3003: Warning: The macro name [ ] is invalid.

Problem 

The Help compiler doesn’t recognize the macro you have entered.

Result 

WinHelp may not be able to run the macro in the compiled Help file.

Solution 

If you meant to use a WinHelp macro, confirm that you have spelled it correctly. Note that macro names are 
always entered in English no matter what language the text of the topic file is in. If the macro is supplied by a 
dynamic-link library (DLL), make certain you have registered the macro name using the RegisterRoutine macro in 
the [CONFIG] section of your project file.



 HC3004: Warning: The variable used in the macro [ ] doesn’t match the 
macro's argument type.

Problem 

You have used a string for a numeric parameter or a number for a string parameter.

Result 

WinHelp will not be able to run the macro in the compiled Help file.

Solution 

Replace the incorrect parameter types and then recompile. If the macro is defined in a custom dynamic-link library 
(DLL), check the RegisterRoutine macro in the project file for the correct parameter types.



 HC3005: Warning: The macro variable [ ] is undefined

Problem 

The specified macro contains a variable that is not recognized by the Help compiler.

Result 

The Help compiler ignores the rest of the macro. WinHelp will not be able to run the macro.

Solution 

Replace incorrect variables and then recompile. 

The following is a list of valid macro variables:

hwndContext

hwndApp

qchPath

qError

lTopicNo

hfs

coForeground

coBackground



 HC3006: Warning: Missing comma in authorable button command

Problem 

You have specified a {button} command without specifying a comma followed by the macro to run when the button 
is clicked.

Result 

The Help compiler ignores the button command.

Solution 

Correct the syntax by editing the authorable button or by deleting it and adding it to the topic again. Then 
recompile the Help file.



 HC3007: Warning: [ ] is an invalid display-state parameter for the macro [ ]

Problem 

A non-supported display state has been specified for a macro that launches a program.

Result 

The Help compiler ignores the rest of the macro. WinHelp may not be able to run the macro.

Solution 

Edit the macro using RoboHELP’s Macro Editor/Wizard or try deleting the macro and re-inserting it again. 



 HC3008: Warning: Missing double quotation mark in macro [ ]

Problem 

There is an unmatched double quotation mark in the macro.

Result 

The Help compiler ignores the rest of the macro. WinHelp cannot run the macro.

Solution 

Add the missing double quotation mark and then recompile. For most macros, it is not necessary to supply 
quotations marks as The Help compiler will supply them for you.



 HC3009: Warning: Missing end quotation mark (') in macro [ ]

Problem 

A start quotation mark has been specified without an end quotation mark.

Result 

The Help compiler ignores the rest of the macro. WinHelp cannot run the macro.

Solution 

Edit the macro using RoboHELP’s Macro Editor/Wizard or try deleting the macro and re-inserting it again.



 HC3010: Warning: The macro name [ ] is undefined

Problem 

The macro name you have used is not a valid WinHelp macro and has not been defined by a RegisterRoutine 
macro.

Result 

The Help compiler ignores the rest of the macro. WinHelp cannot run the macro.

Solution 

If this is a macro that calls a dynamic-link library (DLL) function, add the RegisterRoutine macro to the project file 
that defines this function name. Otherwise, you have probably misspelled the macro name.



 HC3011: Warning: The accelerator [ ] has already been added

Problem 

The accelerator you have used in the AddAccelerator macro has already been used.

Result 

The Help compiler ignores the rest of the macro. You may get a syntax error if WinHelp tries to run the macro.

Solution 

Use another accelerator key. Using the same format for accelerators will help avoid duplication. For example, ‘A’, 
65, and 0x41 are all the same accelerator.



 HC3012: Warning: The macro [ ] doesn’t include a window name

Problem 

The macro requires a window name, and you have not specified one.

Result 

The Help compiler ignores the rest of the macro. WinHelp cannot run the macro.

Solution 

Edit the macro using RoboHELP’s Macro Editor/Wizard and specify the window name. Then save and recompile 
the Help file.



 HC3013: Error: [ ] is not a valid numeric parameter for the macro [ ]

Problem 

The parameter for the specified macro can only be a numeric value or a macro that returns a numeric value, and 
you have specified a string. Some macros accept a limited type of string parameter in place of a number, but if you 
do not use one of those values, you get an error.

Result 

The Help compiler ignores the rest of the macro. WinHelp cannot run the macro.

Solution 

Change the macro parameter in the topic file to a numeric value and then recompile.



 HC3014: Warning: Window name [ ] has already been used

Problem 

The same window type has been specified more than once in the [WINDOWS] section of the project file.

Result 

Only the first definition of the window is used.

Solution 

Delete the duplicate window definition:

1 From RoboHELP Explorer's File menu, select Project Settings. The Project Settings dialog appears.

2 Click the Windows tab.

3 Under Windows, select the duplicate window name and click Delete. 

4 Click OK.

5 Save and recompile the Help file.



 HC3015: Warning: This window position is invalid: [ ]

Problem 

An invalid window position has been used. The window position in a window definition consists of four numbers 
that define the window’s location on the screen and its width and height. The four numbers must be in pixel units 
1024-by-1024 (Windows coordinate system), and they must be enclosed in parentheses and separated by 
commas.

Result 

The Help compiler ignores the window definition.

Solution 

Adjust the window’s position:

1 From RoboHELP Explorer's Edit menu, select Windows.

2 Under Displayed windows, clear all selections except for the window you need to adjust. If you do, only the 
window you want appears in the window display area to the left.

3 In Placement, adjust the window’s top, left, height, and width coordinates. If you are using absolute 
positioning, make sure Use Absolute is selected.

4 Click OK.

5 Save and recompile the Help file.



 HC3016: Warning: Invalid syntax for authorable button: [ ]

Problem 

The syntax used for an authorable button is invalid.

Result 

The Help compiler ignores the {button} statement.

Solution 

Edit the authorable button by right-clicking on it and selecting Properties. Correct the problem or redefine the 
button and click OK. Recompile the Help file.

Typically the problem occurs by leaving out a comma before the macro definition. The correct syntax for an 
authorable button is:

 



 HC3017: Warning: Topic ID for [ ] macro contains invalid characters: [ ]

Problem 

There is an invalid character in the Topic ID.

Result 

The Help compiler ignores the rest of the macro. WinHelp cannot run the macro in the compiled Help file.

Solution 

Edit the topic's properties and re-enter the Topic ID. RoboHELP automatically replaces any incorrect characters 
typed with the underscore (_) character. Save and recompile.



 HC3018: Warning: In the project file, an #include statement is specified 
without a filename

Problem 

An #include line has been specified in the project file, but the line did not include a filename.

Result 

The Help compiler ignores the #include line.

Solution 

Either delete the line or add a correct filename to the statement and then recompile. 



 HC3019: Warning: Missing quotation mark or parenthesis in the macro [ ]

Problem 

There is an unmatched quotation mark or parenthesis.

Result 

The Help compiler ignores the rest of the macro. WinHelp cannot run the macro.

Solution 

Use RoboHELP's Macro Editor/Wizard to correct or redefine the macro. Then recompile the Help file.

If you wish, you can manually add the missing quotation or right parenthesis to the macro definition in the topic file. 
The Help compiler will usually supply the quotes for you — deleting all the quotes in the macro can be an effective 
method for fixing this problem.



 HC3021: Warning: Cannot find the bitmap [ ]

Problem 

The Help compiler is unable to find the bitmap you have specified.

Result 

The Help compiler creates a temporary bitmap containing the filename of the missing bitmap.

Solution 

If the bitmap name is valid, locate the bitmap or add the folder containing the bitmap to the Help project.

To locate the missing bitmap:

1 From RoboHELP Explorer’s Project tab, open the Images and Multimedia folder.

2 Open the Images folder and locate the missing image. (It displays with a red X through the image.)

3 Right-click on the missing image and select Locate.

4 Enter the pathname for the image or navigate to it and click Open. The Image Found dialog appears.

5 Select the option you want to use. You can add the entire folder to the Image Folders (BMROOT), copy the 
image to the current Help project folder location, or copy the image to an existing Image Folder.

6 Click OK.

7 Save and recompile the Help file.



 HC3022: Warning: The bitmap [ ] has already been used as a non-transparent 
bitmap

Problem 

A bitmap cannot be transparent in one instance and non-transparent in another.

Transparent command: {bmxt imagename.BMP}

Non-transparent command: {bmx imagename.BMP}

Result 

The bitmap will always be displayed as non-transparent.

Solution 

Change either bitmap command so that all instances using this bitmap image are either transparent or non-
transparent. You can switch your viewing mode to TrueCode, then use RoboHELP Find & Replace to search for 
the bitmap command and replace it with the one you want – bmxt or bmx. Or you can create a new file for a 
bitmap.



 HC3023: Warning: The bitmap [ ] has already been used as a transparent 
bitmap

Problem 

A bitmap cannot be transparent in one instance and non-transparent in another. 

Transparent command: {bmxt imagename.BMP}

Non-transparent command: {bmx imagename.BMP}

Result 

The bitmap will always be displayed as transparent.

Solution 

Change either bitmap command so that all instances using this bitmap image are either transparent or non-
transparent. You can switch your viewing mode to TrueCode, then use RoboHELP Find & Replace to search for 
the bitmap command and replace it with the one you want – bmxt or bmx. Or you can create a new file for a 
bitmap.



 HC3024: Warning: The window name [ ] contains more than eight characters 
and has been truncated to [ ]

Problem 

The window name is too long.

Result 

The Help compiler truncates the name to 8 characters. If this results in a duplicate window name, you will get 
another warning message.

Solution 

Delete the window from the Help project. Then recreate the window, naming it with 8 characters or less. If the 
window is referenced anywhere in the project – in hotspots, macros, button commands, topics (as the default 
window), or the TOC, you’ll need to remove all references to the window before you can delete it.

To delete the window:

1 From RoboHELP Explorer’s File menu, select Project Settings. The Project Settings dialog appears.

2 Click the Windows tab.

3 Under Windows, select the window and click Delete.

Note: If the window is referenced, you’ll need to remove all references first. Consult the RoboHELP Help 
system for instructions.

4 Click OK. 

To recreate the window:

1 From RoboHELP Explorer's File menu, select New > Window. The New Window dialog appears.

2 In Name, enter a name for the window – 8 characters or less.

3 In Title, enter the title for the window. This title is what the user sees at the top of the window whenever it 
displays.

4 In Template, select the template you want to base this window on.

5 Click OK to create the window.

6 If you need to modify the window’s properties, right-click on it and select Properties. 

7 Make the changes to the window’s buttons, size and location, and so on. Click OK when you’re done.

8 Save and recompile the project.



 HC3025: Warning: Jump to undefined topic ID: [ ]

Problem 

No topic has been defined with the Topic ID specified in the hotspot.

Result 

WinHelp displays the "Topic not found" error message when the user chooses a hotspot with the unresolved Topic 
ID.

Solution 

Usually this warning occurs when there are broken links in the Help project. Even a punctuation mark – like a 
comma or period – that accidentally gets included in the hidden text part of the hotspot can create a broken link. 
Check the Broken Links folder to resolve the problem.

To check the Broken Links folder:

1 From RoboHELP Explorer's Project tab, open the Topics folder, and then open the Broken Links folder.

2 Right-click on the broken link and select Resolve Broken Links. The Resolve Broken Links dialog appears. 
Select the option you want to use to resolve the broken link. If there’s a spelling error (such as included 
punctuation in the hidden text area), the Edit option usually helps you quickly resolve the problem. 

3 Save and recompile the Help file.



 HC3026: Warning: The topic ID [ ] has already been defined in topic [ ] in file [ ]

Problem 

Another topic exists with an identical Topic ID.

Result 

The Help compiler ignores the duplicate Topic ID, so the duplicate topic has no identifier.

Solution 

Change the duplicate Topic ID:

1 From RoboHELP Explorer's Tools menu, select Resolve Duplicate Topics. The Resolve Duplicate Topics 
dialog appears.

2 From the Duplicate Topics Found area, select the Topic ID you want to change.

3 Click Change.

4 Enter the new Topic ID and press Enter to change the selected Topic ID.

5 Click Close when finished.

6 Save and recompile the Help file.



 HC3027: Warning: The following alias line doesn’t contain an '=' character 
separating the topic IDs: [ ]

Problem 

An invalid line has been entered in the [ALIAS] section of the project file.

Result 

The Help compiler ignores the Alias.

Solution 

Change the Alias:

1 From RoboHELP Explorer’s Project tab, open the Project folder, and then open the Aliases folder.

2 Right-click on the Alias that displays with only the Alias icon and select Properties.

3 In Alias, enter the Alias ID.

4 In Topic, make sure the appropriate topic is selected.

5 Click OK.

6 Save and recompile the Help file.



 HC3028: Warning: The bitmap file [ ] is corrupted

Problem 

Either the file is corrupt or it has not been saved as an uncompressed bitmap (.BMP) file. 

Result 

The Help compiler ignores this bitmap, and WinHelp displays the “Unable to display picture” message in the topic 
instead of the bitmap.

Solution 

Replace the bitmap file with one that is not corrupt, or remove the bitmap from the topic.



 HC3029: Warning: The file format of the bitmap file [ ] is unrecognized or 
unsupported

Problem 

Either the file is corrupt or it has not been saved as an uncompressed bitmap (.BMP) file.

Result 

The Help compiler ignores this bitmap, and WinHelp displays the “Unable to display picture” message in the topic 
instead of the bitmap.

Solution 

Convert the bitmap to a supported format:

1 In the Image Workshop, select Open. The Open Image from Project dialog appears.

2 Click Import. The Graphics Converter appears.

3 In Search For, enter the file type and path for this image file.

4 Click Search.

5 From the Files list box, select the image file.

6 Click Destination to make sure the destination file is correct.

7 Select Convert to WinHelp Format (.BMP) During Copy.

8 Click Copy File.

9 Click Exit.

10 Click Cancel to exit the Open Image from Project dialog.

11 You may need to replace the image file inside your Help topics.

12 Recompile the Help file. 



 HC3031: Warning: The Help compiler doesn’t support compressed BMP files: [ 
]

Problem 

The bitmap (BMP) was saved with RLE compression.

Result 

The Help compiler displays the message, “Help Workshop does not support compressed BMP Files”, and 
identifies the directory path of the compressed bitmap.

Solution 

Resave the bitmap in Image Workshop:

1. Right-click on the compressed bitmap.

2. Select Properties.

3. Click the Resize button to open Image Workshop.

4. Save the BMP and exit Image Workshop.

5. Recompile your project.



 HC3032: Warning: The bitmap file [ ] is truncated

Problem 

The size of the bitmap doesn’t match the size of the file. The bitmap is corrupt.

Result 

The Help compiler ignores this bitmap, and WinHelp displays the “Unable to display picture” message in the topic 
instead of the bitmap.

Solution 

Resave or recreate the specified bitmap file.



 HC3033: Warning: The topic ID [ ] contains invalid characters

Problem 

There is an invalid character in the Topic ID footnote.

Result 

The Help compiler doesn’t assign an identifier to the topic.

Solution 

Remove invalid characters from the Topic ID:

1 From RoboHELP Explorer, right-click on the topic and select Properties.
-or-
From Word, right-click on or in the topic and select Topic Properties.
The Topic Properties dialog appears.

2 Click the General tab.

3 In Topic ID, remove any invalid characters.

4 Click OK.

5 Save and recompile the Help file.



 HC3034: Warning: Invalid parameter for TCard macro: [ ]

Problem 

The parameter specified for the TCard macro is invalid.

Result 

The Help compiler ignores the macro, and WinHelp returns an error when it tries to run the macro.

Solution 

Correct the invalid TCard macro definition in the topic file and then recompile.



 HC3035: Warning: Map entry doesn’t specify a numeric value: [ ]

Problem 

The Help compiler expected a numeric value and encountered text instead.

Result 

The Help compiler ignores the entry.

Solution 

Change the entry to a numeric value.



 HC3037: Warning: The map value for [ ] is the same as the map value for [ ]

Problem 

A Map number in the [MAP] section of the project (.HPJ) file was previously mapped to a different Topic ID.

Result 

The Help compiler ignores the line with the duplicate Map number.

Solution 

1 Run the Duplicate Map IDs Report (from RoboHELP Explorer Tools menu) to verify the duplicate Map 
numbers. 

2 Resolve the duplicate Map numbers:

· If your programming team provides the Map files and Map IDs, consult them to resolve this for you. 

· If the Help author provides the Map files and Map IDs, change the Map number on one of the duplicate Map 
IDs. 

3 Save the project and recompile.



 HC3038: Warning: The following topic IDs were not defined in the [MAP] 
section of the project file

Problem 

The Help compiler cannot find the specified Topic IDs listed in the [MAP] section of the project (.HPJ) file.

Result 

The Help compiler ignores the lines in the project file. If the program uses that number in the WinHelp function, 
WinHelp displays the "Help topic not found" error message.

Solution 

Verify that all Topic IDs listed in the [MAP] section of the project file are assigned to topics included in the build and 
that the Topic IDs are spelled correctly. Then recompile the project file.



 HC3041: Warning: The phrase file [ ] exceeds 64K. Phrase compression turned 
off.

Problem 

The Phrase file is invalid and cannot be used.

Result 

The Help compiler cannot perform Phrase compression on the Help file.

Solution 

Delete the Phrase file and then recompile. If the problem still occurs, switch to Hall or Maximum compression.



 HC3042: Warning: The copyright string exceeds 255 characters. It has been 
truncated to the following: [ ].

Problem 

The copyright string is too long.

Result 

The Help compiler truncates the copyright string at 255 characters.

Solution 

Edit the copyright statement:

1 From RoboHELP Explorer's File menu, select Project Settings.
-or-
From Word's RoboHELP menu, select Project Settings.
The Project Settings dialog appears.

2 Click the Project tab.

3 In Copyright Notice, edit the text.

4 Click OK.

5 Recompile the Help file.



 HC3043: Warning: The title string exceeds 127 characters. It has been 
truncated to the following: [ ].

Problem 

The Help system’s title is too long.

Result 

The Help compiler truncates the title string.

Solution 

Edit the title:

1 From RoboHELP Explorer's File menu, select Project Settings.
-or-
From Word's RoboHELP menu, select Project Settings.
The Project Settings dialog appears.

2 Click the Project tab.

3 In Title, edit the text.

4 Click OK when finished.

5 Recompile the Help file.



 HC3044: Warning: Hotspot exceeds [ ] characters: [ ]

Problem 

The hidden text portion of the hotspot is too large.

Result 

The Help compiler doesn’t make the selected text or image a hotspot.

Solution 

Shorten the hotspot in the topic and then recompile.



 HC3045: Warning: Footnote exceeds [ ] characters: [ ]

Problem 

The footnote is too large.

Result 

The Help compiler ignores the footnote.

Solution 

Reduce the length of the footnote text in the topic file and then recompile. For some footnotes, such as the K 
(Index keywords) footnote, you can use several smaller footnotes instead of one larger footnote.



 HC3046: Warning: The [ ] file is not an RTF (Rich Text Format) file. It appears 
to have been saved as a Microsoft Word document

Problem 

You have saved the topic file in Word format instead of RTF format.

Result 

The Help compiler ignores the file.

Solution 

Use the Save As RTF to save the document and recompile. If you still get this warning, make sure the 
RoboHELP.DOT template is attached to the document or use the Import Documentation or Convert Document 
option to turn the DOC file into a Help document.



 HC3047: Warning: No name was specified for the bitmap command

Problem 

The bitmap command ({bmc}, {bml}, or {bmr}) was specified in a topic without a bitmap filename.

Result 

The Help compiler ignores the bitmap command.

Solution 

Re-insert the image:

1 In the appropriate topic, position the cursor where you want the image to appear.

2 From Word's Insert menu, select Help Image. The Insert Help Image dialog appears.

3 Select the image and the attributes you want associated with this image.

4 Click OK.

5 Save and recompile the Help file.



 HC3048: Warning: Nonscrolling region is defined after scrolling region.

Problem 

The Keep With Next attribute was applied to a paragraph after a paragraph that did not have this attribute.

Result 

The Help compiler ignores the Keep With Next attribute; the paragraph is treated as plain text and is displayed as 
part of the topic text displayed in the scrolling region of the topic.

Solution 

Find the text that has the Keep With Next option (marked as a non-scrolling region) and turn off the option.



 HC3049: Warning: Invalid topic IDs in hypergraphic: [ ]

Problem 

A Topic ID in the hotspot image SHED (.SHG) contains invalid characters.

Result 

The hotspot is not active on the image in the Help file.

Solution 

Edit the hotspot image:

1 Open the hotspot image in the Image Workshop.

2 Right-click on the hotspot area and select Properties. The Hotspot Properties dialog appears.

3 Select the appropriate Topic ID.

4 Make any other changes you need to make.

5 Click OK.

6 Save the image.

7 Recompile the Help file.



 HC3050: Warning: Missing topic IDs in hypergraphic: [ ]

Problem 

A hotspot was specified on a hotspot image (.SHG), but no Topic ID was specified.

Result 

The hotspot is not active on the image in the compiled Help file.

Solution 

Edit the hotspot image:

1 Open the hotspot image in the Image Workshop.

2 Right-click on the hotspot area and select Properties. The Hotspot Properties dialog appears.

3 Select the appropriate Topic ID.

4 Make any other changes you need to make.

5 Click OK.

6 Save the image.

7 Recompile the Help file.



 HC3051: Warning: Cannot jump to window [ ]. No windows have been defined 
in the project file.

Problem 

There is no [WINDOWS] section in the Help project file (.HPJ), so you cannot jump to any window type other than 
Main.

Result 

The jump is not active in the Help file.

Solution 

Use RoboHELP to define the secondary window and then recompile.

To define a window:

1 From RoboHELP Explorer's File menu, select New > Window.

2 In Name, enter an internal name for the window 8-characters or less. (The name is only used by the Help 
author in the Help project.)

3 In Title, enter the name for the titlebar when the window is displayed. (Users see this title.)

4 In Template, select the template.

5 Click OK.

6 If you want, right-click on the window and select Properties to change the window’s properties. Click OK when 
you’re done.

To select a window for a hotspot:

1 Right-click inside the hotspot text in the topic and select Properties. The Help Hotspot Properties dialog 
appears.

2 In Window, select the window.

3 Click OK.

4 Save the Help document.

5 Recompile the Help file.



 HC3052: Warning: The window name [ ] has not been defined in the project 
file.

Problem 

You have attempted to display a topic in a window that has not been defined in your Help project file (.HPJ).

Result 

The hotspot is not active in the Help file.

Solution 

Either define the secondary window or change the window reference to select an existing window. Then recompile. 
Windows are referenced in hotspots, hotspot images, topic defaults (Topic Properties: Advanced tab), TOC 
Pages, and Default Window (Project Settings: Contents tab) for the Contents file. 

To define a window:

1 From RoboHELP Explorer's File menu, select New > Window.

2 In Name, enter an internal name for the window 8-characters or less. (The name is only used by the Help 
author in the Help project.)

3 In Title, enter the name for the titlebar when the window is displayed. (Users see this title.)

4 In Template, select the template.

5 Click OK.

6 If you want, right-click on the window and select Properties to change the window’s properties. Click OK when 
you’re done.

To select a window for a hotspot:

1 Right-click inside the hotspot text in the topic and select Properties. The Help Hotspot Properties dialog 
appears.

2 In Window, select the window.

3 Click OK.

4 Recompile the Help file.



 HC3053: Warning: The project file contains more than 255 window definitions

Problem 

You have defined more than 255 window types in your project file.

Result 

The Help compiler ignores the additional window definitions. If you attempt to jump to a topic in one of the window 
definitions beyond the first 255, you will get an error message about the window type not being defined.

Solution 

Remove the extra windows from the Help project and then recompile.

To remove windows:

1 From RoboHELP Explorer's File menu, select Project Settings. The Project Settings dialog appears.

2 Click the Windows tab.

3 Under Windows, select the window and click Delete.

4 Click OK to save your changes.

Note: If the window is referenced, you’ll need to remove all references first. Consult the RoboHELP Help 
system or User’s Manual for instructions.

5 Recompile the Help file.



 HC3054: Warning: Build tag contains invalid characters. The following is 
invalid: [ ].

Problem 

A build tag in the [BUILDTAGS] section contains something other than an alphanumeric character or the 
underscore (_) character.

Result 

The Help compiler ignores the line containing invalid characters.

Solution 

Edit the build tag (RoboHELP Explorer Project tab, Project folder, Build Tags folder) so that it contains only valid 
characters. Make any necessary changes in topics containing the specified build tag and then recompile. 



 HC3055: Warning: The build tag [ ] has already been used

Problem 

The build tag in the [BUILDTAGS] section of your project file has already been declared previously in the same 
section.

Result 

The Help compiler uses the first build tag and ignores the duplicate build tag.

Solution 

Remove (or rename) the duplicate build tags in the Help project file (RoboHELP Explorer Project tab, Project 
folder, Build Tags folder) and then recompile.



 HC3056: Warning: The window name [ ] in the macro [ ] contains more than 
eight characters and has been truncated to [ ]

Problem 

The window name you specified in the macro is invalid due to its length.

Result 

The Help compiler ignores the window definition in this macro.

Solution 

Edit the macro hotspot using the Macro Editor/Wizard and specify a valid window name. Then recompile the Help 
file.



 HC3057: Warning: A hotspot is defined with a macro (using !), but the macro is 
not specified

Problem 

You started a hotspot with a ‘!’ character, but did not follow it with a macro.

Result 

The Help compiler ignores the macro call from the hotspot.

Solution 

Edit or redefine the macro hotspot using the Macro Editor/Wizard. Make certain that all text from the ‘!’ to the end 
of the macro is marked as hidden. Then recompile the Help file.



 HC3058: Warning: Topic ID for hotspot contains invalid characters: [ ]

Problem 

An invalid Topic ID has been used in a hotspot. 

Result 

The hotspot is not active in the Help file.

Solution 

1 Resolve any broken links in the Broken Links folder (RoboHELP Explorer Project tab, Topics folder, Broken 
Links folder). 

2 Edit or redefine the hotspot (right-click in the hotspot and select Properties). 

3 Recompile the Help file.



 HC3059: Warning: A hotspot is specified without a macro or topic ID

Problem 

A hotspot was specified without specifying either a Topic ID or a macro.

Result 

The hotspot is not active in the Help file.

Solution 

1 Edit or redefine the hotspot. 

2 Verify the Topic ID or macro is valid, spelled correctly, and formatted as hidden text. 

3 Recompile the Help file.



 HC3060: Warning: Window name is specified for a pop-up jump

Problem 

You have specified a window name in a pop-up hotspot.

Result 

The hotspot is not active in the Help file.

Solution 

Remove the right angle bracket and secondary window name from the pop-up hotspot, or change the single 
underline to double underline (for a topic jump). Then recompile the project file.



 HC3062: Warning: Window definition is missing an '=' character: [ ]

Problem 

The window definition in the [WINDOWS] section is invalid.

Result 

The Help compiler ignores the line.

Solution 

Edit the window:

1 From RoboHELP Explorer's Edit menu, select Windows.

2 Under Displayed windows, clear all selections except for the window you need to edit. If you do, only the 
window you want appears in the window display area to the left.

3 Modify the window’s definition and click OK.

4 Recompile the Help file.



 HC3063: Warning: Window definition doesn’t contain anything after the '=' 
character: [ ]

Problem 

The window definition in the [WINDOWS] section is invalid.

Result 

The Help compiler ignores the line.

Solution 

Edit the window:

1 From RoboHELP Explorer's Edit menu, select Windows.

2 Under Displayed windows, clear all selections except for the window you need to edit. If you do, only the 
window you want appears in the window display area to the left.

3 Modify the window’s definition and click OK.

4 Recompile the Help file.



 HC3064: Warning: Window name is not defined before the '=' character: [ ]

Problem 

The window definition in the [WINDOWS] section is invalid.

Result 

The Help compiler ignores the line.

Solution 

Delete the window and recreate it. 

To delete the window:

1 From RoboHELP Explorer’s File menu, select Project Settings. The Project Settings dialog appears.

2 Click the Windows tab.

3 Under Windows, select the window and click Delete.

Note: If the window is referenced, you’ll need to remove all references first. Consult the RoboHELP Help 
system for instructions.

4 Click OK. 

To recreate the window:

1 From the Project Settings: Windows tab, click New.
-or-
From RoboHELP Explorer's File menu, select New > Window. 
The New Window dialog appears.

2 In Name, enter a name for the window – 8 characters or less.

3 In Title, enter the title for the window. This title is what the user sees at the top of the window whenever it 
displays.

4 In Template, select the template you want to base this window on.

5 Click OK to create the window.

6 If you need to modify the window’s properties, right-click on it and select Properties. 

7 Make any changes to the window’s buttons, size and location, and so on. Click OK when you’re done.

8 Save and recompile the project.



 HC3065: Warning: A closing quotation mark () is missing in window caption: [ ]

Problem 

The window definition in the [WINDOWS] section is invalid.

Result 

The Help compiler ignores the window definition.

Solution 

Edit the window:

1 From RoboHELP Explorer's Edit menu, select Windows. 

2 Under Displayed windows, clear all selections except for the window you need to edit. If you do, only the 
window you want appears in the window display area to the left.

3 In Title, delete the text and then enter the caption name again.

4 Click OK.

5 Recompile the Help file.



 HC3066: Warning: Window caption contains more than 50 characters: [ ]

Problem 

The window definition in the [WINDOWS] section contains a title that is too long.

Result 

The Help compiler ignores the window definition.

Solution 

Edit the window:

1 From RoboHELP Explorer's Edit menu, select Windows. 

2 Under Displayed windows, clear all selections except for the window you need to edit. If you do, only the 
window you want appears in the window display area to the left.

3 In Title, edit the window’s title and click OK.

4 Recompile the Help file.



 HC3067: Warning: The [ ] command in the [OPTIONS] section of the project file 
doesn’t specify a value after the '=' character

Problem 

You have specified an invalid command in the [OPTIONS] section of your project file.

Result 

The Help compiler ignores the line.

Solution 

Edit the option and then recompile.



 HC3068: Warning: The following line in the [OPTIONS] section of the project 
file doesn’t contain an '=' character: [ ]

Problem 

You have specified an invalid command in the [OPTIONS] section of your project file.

Result 

The Help compiler ignores the line.

Solution 

Edit the option and then recompile.



 HC3069: Warning: The [ ] option in the [OPTIONS] section of the project file is 
not recognized

Problem 

You have specified an invalid command in the [OPTIONS] section of your project file.

Result 

The Help compiler ignores the line.

Solution 

Edit the option and then recompile.



 HC3070: Warning: the major browse string exceeds 50 characters: [ ]

Problem 

The name to the left of the colon in a browse footnote contains too many characters.

Result 

The Help compiler truncates the browse sequence name to 50 characters. The browse sequence may be affected.

Solution 

Shorten the browse sequence name using either the Browse Sequence Editor (easiest) or the Document 
Properties dialog.

To edit the browse sequence name from the Browse Sequence Editor:

1 From RoboHELP Explorer's Tools menu, select Browse Sequence Editor. The Browse Sequence Editor 
appears.

2 In Browse Sequences, select the browse sequence.

3 Click Rename.

4 Type the new browse sequence name and press Enter.

5 Click OK. RoboHELP applies the new browse sequence name to all topics in this browse sequence.

6 Recompile the project.

To edit the browse sequence name from the Document Properties dialog:

1 From RoboHELP Explorer's Project tab, open the Topics folder. Then right-click on the Help document 
containing the browse string and select Properties.
-or-
From Word's RoboHELP menu, select Document Properties.
The Document Properties dialog appears.

2 Click the General tab.

3 In Browse String, shorten the name of the browse string.

4 Select the Apply Browse Settings to Existing Topics option.

5 Click OK.

6 Recompile the Help file.



 HC3071: Warning: One or more browse sequences are set, but browse buttons 
are not enabled in any window

Problem 

You have specified a browse footnote, but none of the windows defined for the Help file contains browse buttons.

Result 

The browse information is stored in the Help file (taking up space), but users can’t access the browse sequence. 

Solution 

You have several options:

· Add browse buttons to one of the existing windows in your Help project (RoboHELP Explorer Edit menu, 
Windows).

· Create a new “dummy” window that enables browse buttons (RoboHELP Explorer File menu, New > Window). 
You can do this even though the Help file never specifies the dummy window to display topics.

· Remove the browse sequences (Browse Sequence Editor or the Document Properties: General tab).



 HC3072: Warning: The macro [ ] doesn’t include a control panel name

Problem 

The macro expected a control panel name, but you didn’t specify one.

Result 

The Help compiler ignores the ControlPanel macro.

Solution 

Edit the macro and specify a control panel name. Then recompile.



 HC3073: Warning: No section is defined for the line: [ ]

Problem 

The section heading on the specified line is not complete, or the first entry in the project (.HPJ) file is not a section 
heading.

Result 

The Help compiler ignores the section heading on this line and all succeeding lines until it encounters a valid 
section heading.

Solution 

Edit the specified section in the project file. Then recompile the project file.



 HC3074: Warning: The [ ] section is not recognized by this version of Help 
Workshop

Problem 

Your project file contains a section that the Help compiler doesn’t recognize.

Result 

The Help compiler ignores the section heading.

Solution 

Verify that the section headings in the project file are valid and spelled correctly and then recompile.



 HC3075: Warning: The [ ] section doesn’t follow the [OPTIONS] section in the 
project file

Problem 

You have specified a section that requires the [OPTIONS] section before you have specified the [OPTIONS] 
section.

Result 

The Help compiler may not be able to find some files, or the files may be compiled incorrectly.

Solution 

Open the Help project file (.HPJ) into RoboHELP and then save it. RoboHELP automatically saves the sections in 
the correct order.



 HC3079: Warning: The alias string [ ] has already been aliased [ ]

Problem 

A Topic ID can have only one Alias.

Result 

The Help compiler ignores this line.

Solution 

Remove the duplicate Alias:

1 From RoboHELP Explorer's Project tab, open the Project folder, and then open the Aliases folder.

2 Right-click on the duplicate Alias and select Delete.

3 Recompile the Help file.



 HC3080: Warning: The string [ ] has already been aliased [ ]

Problem 

You cannot alias an Alias.

Result 

The Help compiler ignores this line.

Solution 

1 From RoboHELP Explorer's Project tab, open the Project folder, and then open the Aliases folder.

2 Right-click on the duplicate Alias and select Delete.

3 Recompile the project.



 HC3081: Warning: Both alias and topic ID are identical: [ ]

Problem 

The alias is the same as the Topic ID.

Result 

The Help compiler ignores this line.

Solution 

Change the Alias ID:

1 From RoboHELP Explorer's Project tab, open the Project folder, and then open the Aliases folder.

2 Right-click on the Alias you want and select Properties. The Alias Properties dialog appears.

3 In Alias, edit the name of the Alias and click OK.

4 Recompile the Help file.



 HC3082: Warning: The map number [ ] is not a valid number: [ ]

Problem 

A context number in the [MAP] section of the project (.HPJ) file contains invalid characters.

Result 

The Help compiler ignores this line.

Solution 

The solution depends upon who provides the Map files and Map IDs: 

· If the Programmer provides the Map files and Map IDs to you, bring the problem to the attention of your 
Programmer. 

· If the Help author provides the Map files and Map IDs, try removing any unused Map IDs (RoboHELP Explorer 
Tools menu, Remove Unused Map IDs). You can also directly edit the Map ID number for the Map ID – either 
from RoboHELP Explorer's Project tab, Project folder, Map IDs folder or from the Topic Properties: 
Advanced tab.



 HC3083: Warning: Invalid syntax for window color: [ ]

Problem 

The syntax specified for the window’s color in the [WINDOWS] section of your project file is invalid.

Result 

The Help compiler ignores the window definition.

Solution 

Edit the window’s color definition:

1 From RoboHELP Explorer's Edit menu, select Windows. 

2 Under Displayed windows, clear all selections except for the window you need to edit. If you do, only the 
window you want appears in the window display area to the left.

3 Under Window Color, click Nonscroll or Client – depending on where the problem color is selected. The 
Color dialog appears.

4 Select a valid window color and click OK to exit the Color dialog. 

5 Click OK to save the changes to the window.

6 Recompile the Help file.



 HC3084: Warning: Invalid window syntax: [ ]

Problem 

The syntax you have specified for the window in the [WINDOWS] section of your project file is invalid.

Result 

The Help compiler ignores the invalid window definition.

Solution 

Edit the window:

1 From RoboHELP Explorer's Edit menu, select Windows.

2 Under Displayed windows, clear all selections except for the window you need to edit. If you do, only the 
window you want appears in the window display area to the left.

3 Make any adjustments or corrections to the window and click OK.

4 Recompile the Help file.



 HC3086: Warning: Window position is out of range: [ ]

Problem 

One or more of the window position coordinates exceed the limit of 1024.

Result 

The Help compiler ignores the invalid window definition.

Solution 

Edit the window:

1 From RoboHELP Explorer's Edit menu, select Windows.

2 Under Displayed windows, clear all selections except for the window you need to edit. If you do, only the 
window you want appears in the window display area to the left.

3 Under Placement, adjust the top, left, width, or height of the window. If you’re using absolute coordinates, 
make sure Use Absolute is selected. (Otherwise, clear this selection.)

4 Click OK.

5 Recompile the Help file.



 HC3087: Warning: The following filename exceeds 259 characters: [ ]

Problem 

You have specified a filename that contains too many characters.

Result 

The Help compiler ignores the specified file.

Solution 

Shorten the filename. (You can rename Help documents from RoboHELP Explorer's Project tab by right-clicking 
on them and selecting Rename.) Then recompile the project file.



 HC3088: Warning: More than 20 font ranges are mapped

Problem 

You have specified too many font ranges.

Result 

The Help compiler ignores additional font ranges.

Solution 

Remove the excess ranges and then recompile. 



 HC3089: Warning: Invalid font range: [ ]

Problem 

The font range is invalid.

Result 

The Help compiler ignores the option.

Solution 

Edit the font range and then recompile. 



 HC3090: Warning: Current font range overlaps previously defined range: [ ]

Problem 

Two or more font ranges overlap each other.

Result 

The Help compiler uses the first range and ignores the second mapping.

Solution 

Edit the font range and then recompile. 



 HC3091: Warning: Unrecognized forced font name: [ ]

Problem 

You have tried to force all font names to an invalid font.

Result 

The Help compiler ignores the font name and uses the default MS Sans Serif font.

Solution 

Change the font name in the project file to a supported font and then recompile. 



 HC3092: Warning: This version of the project file is not supported by this The 
Help compiler

Problem 

The project file was created with a more recent version of the Help compiler than you are currently using.

Result 

The Help compiler may remove options or sections.

Solution 

Contact Technical Support to get a more recent version of the Help compiler.



 HC3093: Warning: Keyword type is not a letter or number. [ ] is invalid

Problem 

An invalid character has been used for the MULTIKEY option.

Result 

The Help compiler ignores the attempted keyword table assignment on this line.

Solution 

Edit the MULTIKEY option in the Help project file and then recompile.



 HC3094: Warning: More than three keyword types (besides 'K' and 'A') defined

Problem 

More than three keywords have been defined using the MULTIKEY option.

Result 

The Help compiler ignores the additional keyword types.

Solution 

Remove the extra MULTIKEY options from the project file and then recompile.



 HC3096: Warning: The font name [ ] is longer than 31 characters

Problem 

The font name is invalid because it is too long.

Result 

The Help compiler ignores the option on this line.

Solution 

This is a nuisance warning that doesn’t affect the Help file at all. You can ignore this warning.



 HC3097: Warning: The [BUILDTAGS] section is missing from the project file

Problem 

A BUILD option was specified in the Help project file, but no [BUILDTAGS] section was specified.

Result 

The Help compiler includes all topics in the build.

Solution 

There are two solutions to this problem:

· Add a build tag to the project.

· Specify the topics to include or exclude by adding a build tag. 

To add a build tag to the Help project:

1 From RoboHELP Explorer's File menu, select New > Build Tag. The New Build Tag dialog appears.

2 In Build Tag, enter the name you want to give this build tag.

3 Recompile the Help file.

To add a build tag to more than one topic at a time:

1 From RoboHELP Explorer's Topic List, select the topics.

2 Right-click and select Build tags. The Build tags dialog appears.

3 Under Select Build Tags, select one or more build tags for these topics.

4 Click OK.

5 Recompile the Help file.



 HC3098: Warning: Invalid build tag expression

Problem 

The BUILD option specifies an invalid expression.

Result 

The Help compiler ignores the line with the invalid expression.

Solution 

Choose from two solutions:

· Add or edit the build expression for the Help project file.

· Add a build tag to the Help project.

To add or edit a build expression:

1 From RoboHELP Explorer's File menu, select Project Settings.
-or-
From Word's RoboHELP menu, select Project Settings.
The Project Settings dialog appears.

2 Click the Advanced tab.

3 In Build Expression, enter or edit the build expression. 

4 Click OK.

5 Recompile the Help file.

To add a build tag to the Help project:

1 From RoboHELP Explorer's File menu, select New > Build Tag. The New Build Tag dialog appears.

2 In Build Tag, enter the name you want to give this build tag.

3 Recompile the Help file.



 HC3099: Warning: Build expression too complex

Problem 

The build expression in the project (.HPJ) file has too many expressions or is nested too deeply.

Result 

The Help compiler includes all topics in the build.

Solution 

Edit and simplify the build expression or remove it.

To edit a build expression:

1 From RoboHELP Explorer's File menu, select Project Settings.
-or-
From Word's RoboHELP menu, select Project Settings.
The Project Settings dialog appears.

2 Click the Advanced tab.

3 In Build Expression, simplify the build expression syntax.

4 Click OK.

5 Recompile the Help file.

To delete a build expression:

1 From RoboHELP Explorer's File menu, select Project Settings.
-or-
From Word's RoboHELP menu, select Project Settings.
The Project Settings dialog appears.

2 Click the Advanced tab.

3 In Build Expression, delete the text.

4 Click OK.

5 Recompile the Help file.



 HC3100: Note: Build expression missing from file

Problem

A build expression is not defined in the project (.HPJ) file.

Result

The Help Compiler recognizes that no build expression is defined. A message is issued so that you can include 
one, if so desired; but it’s not necessary to do so.

Solution

Ignore the warning or create a build expression.



 HC3101: Warning: Unknown build error

Problem

Help Workshop was not able to interpret the BUILD option correctly.

Result

Help Workshop includes all topics in the build.

Solution

You can either:

· Add or edit the build expression.

· Specify the topics to include or exclude using build tags.

To add or edit a build expression:

1 From RoboHELP Explorer's File menu, select Project Settings.
-or-
From Word's RoboHELP menu, select Project Settings.
The Project Settings dialog appears.

2 Click the Advanced tab.

3 In Build Expression, enter or edit the build expression.

4 Click OK.

5 Recompile the Help file.

To add a build tag to more than one topic at a time:

1 From RoboHELP Explorer's Topic List, select the topics.

2 Right-click and select Build tags. The Build tags dialog appears.

3 Under Select Build Tags, select one or more build tags for these topics.

4 Click OK.

5 Save and recompile the Help file.



 HC3102: Warning: No macro is specified for the entry macro footnote

Problem 

You have specified an entry macro footnote, but the footnote did not contain any macros.

Result 

The Help compiler ignores the entry macro footnote.

Solution 

Add a macro to the entry macro footnote or remove the footnote marker. Then recompile the Help file.



 HC3103: Warning: The entry macro footnote doesn’t precede text

Problem 

The entry macro footnote was specified after text was specified for the topic. In most cases, this is due to a 
missing page break between Help topics.

Result 

The Help compiler ignores the entry macro footnote.

Solution 

Find where the topics should be split (look for the footnotes and topic title) and add a page break at the beginning 
of the line. Save and recompile the Help file.



 HC3104: Warning: The topic ID footnote (#) doesn’t specify a topic ID

Problem 

You have a specified a Topic ID footnote that doesn’t contain any characters.

Result 

The Help compiler doesn’t assign the topic an identifier.

Solution 

Add a valid Topic ID to the footnote and then recompile.



 HC3105: Warning: The minor browse string exceeds 50 characters: [ ]

Problem 

The browse string to the right of the colon is larger than 50 characters.

Result 

The Help compiler truncates the string, which may affect the browse sequence itself.

Solution 

Shorten the browse sequence on the Topic Properties: Advanced tab of the affected topics. (You may also need 
to shorten the browse sequence on the Document Properties: General tab.) Save and recompile the Help file. 



 HC3106: Warning: Browse footnote (+) doesn’t appear before any text

Problem 

The browse sequence footnote (+) doesn’t precede the first paragraph of the topic. In most cases, this is due to a 
missing page break between Help topics.

Result 

The Help compiler ignores the browse sequence footnote.

Solution 

Find where the topics should be split (look for the footnotes and topic title) and add a page break at the beginning 
of the line. Save and recompile the Help file.



 HC3107: Warning: A browse sequence has already been defined for this topic

Problem 

The browse sequence footnote (+) has been specified twice in the same topic. In most cases, this is due to a 
missing page break between Help topics.

Result 

The Help compiler uses the first browse sequence footnote and ignores the duplicate footnote.

Solution 

Find where the topics should be split (look for the footnotes and topic title) and add a page break at the beginning 
of the line. Save and recompile the Help file. 



 HC3108: Warning: The title footnote ($) doesn’t appear before any text

Problem 

The title footnote doesn’t precede the first paragraph of the topic. In most cases, this is due to a missing page 
break between Help topics.

Result 

The Help compiler ignores the title footnote, and the topic doesn’t have any title.

Solution 

Find where the topics should be split (look for the footnotes and topic title) and add a page break at the beginning 
of the line. Save and recompile the Help file.



 HC3109: Warning: The title footnote ($) doesn’t contain any text

Problem 

A title footnote was specified that doesn’t contain any text.

Result 

The Help compiler ignores the title footnote, and the topic doesn’t have any title.

Solution 

Add a title to the topic:

1 From RoboHELP Explorer, right-click on the topic and select Properties.
-or-
From Word, right-click anywhere in the topic and select Topic Properties.
The Topic Properties dialog appears.

2 Click the General tab.

3 In Title, enter the title for the topic.

4 Click OK.

5 Save and recompile the project.



 HC3110: Warning: A title has already been defined for this topic

Problem 

A title footnote has already been specified for the topic. In most cases, this is due to a missing page break 
between Help topics.

Result 

The Help compiler uses the first title footnote and ignores the duplicate title footnote.

Solution 

Find where the topics should be split (look for the footnotes and topic title) and add a page break at the beginning 
of the line. Save and recompile the Help file.



 HC3111: Warning: This topic contains keywords but no title

Problem 

One or more keywords have been specified for the topic, but a title footnote was not specified.

Result 

If no title is specified for the topic, and the keyword appears in more than one topic (including other Help files), 
WinHelp will display “Untitled topic #n” in the Topics Found dialog box.

Solution 

For standard topics – add a title:

1 From RoboHELP Explorer, right-click on the topic and select Properties.
-or-
From Word, right-click anywhere in the topic and select Topic Properties.
The Topic Properties dialog appears.

2 Click the General tab.

3 In Title, enter the title for the topic.

4 Click OK.

5 Save and recompile the project.

For popup topics – remove the keyword:

1 From RoboHELP Explorer, right-click on the topic and select Properties.
-or-
From Word, right-click anywhere in the topic and select Topic Properties.
The Topic Properties dialog appears.

2 Click the Index tab.

3 Remove all keywords.

4 Click OK.

5 Save and recompile the Help file.



 HC3112: Warning: The build footnote (*) is not the first footnote in the topic

Problem 

The build footnote doesn’t precede all other text and footnotes in the topic. In most cases, this is due to a missing 
page break between Help topics.

Result 

The Help compiler ignores the build tag footnote, and the topic is not assigned a build tag.

Solution 

Find where the topics should be split (look for the footnotes and topic title) and add a page break at the beginning 
of the line. Save and recompile the Help file.



 HC3113: Warning: Build tag is longer than 32 characters: [ ]

Problem 

The build tag is too long when used in conjunction with the BUILD option in the project file.

Result 

The Help compiler ignores the build tag assigned to the topic.

Solution 

There are two ways to resolve this problem:

· Delete the build tag and re-add it with a shorter name.

· Specify topics to include or exclude from the build.

To delete a build tag and then re-add it:

1 From RoboHELP Explorer's Project tab, open the Project folder, and then open the Build Tags folder.

2 Right-click on the build tag and select Delete.

3 From the File menu, select New > Build Tag. The New Build Tags dialog appears.

4 In Build Tag, enter the name (32 characters or less) of the build tag.

5 Click OK.

6 Recompile the Help file.

To add a build tag to more than one topic at a time:

1 From RoboHELP Explorer's Topic List, select the topics.

2 Right-click and select Build tags. The Build tags dialog appears.

3 Under Select Build Tags, select one or more build tags for these topics.

4 Click OK.

5 Save and recompile the Help file.



 HC3114: Warning: The bitmap [ ] has been used as part of another {bmx} 
command

Problem 

Two {bmx} commands that specify bitmaps for multiple color depths have a bitmap in common but are otherwise 
different or in a different order. 

Result 

WinHelp will treat the shared bitmap files as separate files, and this effectively doubles the space required for each 
of the specified bitmaps.

Solution 

Make sure that bitmap commands that are intended to be identical include the same bitmaps in the same order.



 HC3116: Warning: Table has more than [ ] columns

Problem 

The table has more columns than WinHelp is able to display.

Result 

The Help compiler treats the additional columns as one table cell.

Solution 

Reduce the number of table columns and then recompile.



 HC3117: Warning: Side-by-side paragraphs are not supported

Problem 

Side-by-side paragraph formatting has been used.

Result 

The Help compiler ignores the side-by-side paragraph formatting.

Solution 

Convert the side-by-side paragraphs to a table or a tabbed paragraph and recompile.



 HC3118: Warning: Unrecognized RTF (Rich Text Format) graphics format

Problem 

An embedded bitmap contains a format that the Help compiler doesn’t recognize. The Help compiler supports only 
Windows bitmaps (.BMP), Windows device-independent bitmaps (.DIB), and Windows metafiles (.WMF). Make 
sure that you have not used Macintosh picture formats.

Result 

The Help compiler ignores the specified graphic.

Solution 

Convert the graphic and recompile. You can either do a screen shot of the graphic and use RoboHELP’s Paste as 
Help Image or use RoboHELP’s Import feature on the Insert Help Image dialog.



 HC3119: Warning: Hash conflict between [ ] and [ ]. One of these topic IDs 
must be changed.

Problem 

The hash algorithm used by The Help compiler to convert a Topic ID into an internal number that WinHelp uses, 
has generated the same hash value for both of the listed Topic IDs.

Result 

WinHelp displays the topic with the first Topic ID whenever the user chooses a hotspot containing either Topic ID.

Solution 

Change one of the specified Topic IDs and then recompile.



 HC3120: Warning: The LANGUAGE option [ ] is not supported

Problem 

The LANGUAGE option has been specified. This option is no longer supported.

Result 

The Help compiler uses the default English (U.S.) sorting order.

Solution 

Contact Technical Support.



 HC3121: Warning: Invalid version of Ftsrch.dll

Problem 

The version of FTSRCH.DLL on your system is invalid.

Result 

Neither Hall nor Maximum compression can be used and no index file is created for full text search.

Solution 

Reinstall FTSRCH.DLL from your Windows 95 or later or Windows NT 4 or later installation disks. Then reopen 
your project in RoboHELP and recompile.



 HC3123: Warning: Missing '=' character in REPLACE option: [ ]

Problem 

The syntax for the REPLACE option is invalid.

Result 

The Help compiler ignores the entire option.

Solution 

Contact Technical Support.



 HC3124: Warning: The TMP folder [ ] is invalid

Problem 

The folder name is invalid.

Result 

The Help compiler uses the default folder for temporary files.

Solution 

Create or select a valid TMP folder:

1 From RoboHELP Explorer's File menu, select Project Settings.
-or-
From Word's RoboHELP menu, select Project Settings.
The Project Settings dialog appears.

2 Click the Advanced tab.

3 In Temp Directory, enter or navigate to the appropriate temporary folder.

4 Click OK.

5 Recompile the Help file.



 HC3126: Warning: The window (>) footnote doesn’t appear after the topic ID 
(#) footnote

Problem 

The window footnote was placed before the Topic ID footnote.

Result 

The Help compiler ignores the window footnote.

Solution 

Reposition the window footnote after the Topic ID footnote and then recompile.



 HC4001: Warning: Cannot find or load Ftsrch.dll

Problem 

The Help compiler cannot find the FTSRCH.DLL file.

Result 

Neither Maximum nor Hall compression can be used and no index file is created for full text search.

Solution 

Reinstall FTSRCH.DLL from your Windows 95 or later or Windows NT 4 or later installation disks. Then open the 
Help project in RoboHELP and recompile.



 HC4002: Warning: The RTF file [ ] is corrupted at offset [ ]

Problem 

The Help compiler encountered an error while processing the topic (.RTF) file. This problem can occur when the 
number of opening and closing braces don’t match, when the end of the file is reached before all columns of a 
table have been specified, or when the number specified for an RTF token is invalid.

Result 

The Help compiler ignores the rest of the topic file.

Solution 

Open the file and save it again as Rich Text Format (RTF) and then recompile. If the problem persists, look for 
errors in the topic file.

This message should not appear if you are using Microsoft Word for Windows, Microsoft Word for MS-DOS, or 
Microsoft Word for the Macintosh.. Check the RTF syntax and then recompile. If you are using Microsoft Word for 
the Macintosh, transfer the file to the PC again, and then recompile.



 HC4003: Warning: An error occurred attempting to read the file [ ]

Problem 

The Help compiler can not read the specified file. Another program may have locked the file, or if the file is on a 
network, the network may be down.

Result 

The Help compiler ignores the file.

Solution 

Check the file and its path. Correct any errors and then recompile.



 HC4004: Warning: File is not an RTF (Rich Text Format) file

Problem 

The specified file has not been saved as an RTF file.

Result 

The Help compiler ignores the file.

Solution 

Resave the file as RTF and then recompile.



 HC4005: Warning: The [ ] Help file has not been created

Problem 

Either there are no topics to compile or there are no topics with the build expression specified. The Help compiler 
reached the end of all topic files without encountering any text.

Result 

The Help compiler doesn’t create a Help file.

Solution 

Confirm that you have specified at least one Help document file that contains topics with text. If all topics contain 
build tags, you must specify at least one build expression to include on the Project Settings: Advanced tab. 
Correct any errors and recompile the project.



 HC4006: Warning: The folder [ ] specified for the [ ] option doesn’t exist

Problem 

A nonexistent folder has been specified. Either the folder name was specified incorrectly, or it points to a network 
location that doesn’t (currently) exist.

Result 

The Help compiler uses the current working folder.

Solution 

Open the HPJ file in Notepad and remove or correct the specified folder.



 HC4007: Warning: The [ ] option [ ] is not a valid value

Problem 

The value specified for the option is invalid.

Result 

The Help compiler ignored the option.

Solution 

Specify a valid option value. (Look at the tabs in Project Settings and Options.) Try resaving and recompiling.



 HC4008: Warning: Cannot find or load Ftsrch.dll. Hall compression turned off

Problem 

The Help compiler either cannot find the FTSRCH.DLL file, or it is out of date or corrupted.

Result 

Neither Maximum nor Hall compression can be used and no index file is created for full text search.

Solution 

Reinstall FTSRCH.DLL from Windows 95 or later Windows NT 4 or later installation disks. Then reopen the project 
in RoboHELP and recompile.



 HC4009: Warning: The topic ID specified in the project file as the default topic 
doesn’t exist

Problem 

You have specified a default Topic ID in the project file, but none of your topics contains that Topic ID.

Result 

The Help compiler uses the first topic in the build as the default topic.

Solution 

Select a valid Topic ID for the default topic:

1 From RoboHELP Explorer's File menu, select Project Settings.
-or-
From Word's RoboHELP menu, select Project Settings.
The Project Settings dialog appears.

2 Click the Project tab.

3 In Default Topic, select the appropriate Topic ID.

4 Click OK.

5 Recompile the project.



 HC4010: Warning: There are more opening braces than closing braces

Problem 

When the Help compiler reached the end of the file, the number of opening and closing braces didn’t match. 
Usually this is due to a WinHelp bug that applies hotspot formatting to bulleted or numbered lists, where the first 
word is part of a hotspot. The bullet or number only appears with the hotspot formatting in the compiled Help file – 
not in the source Help document. 

Result 

This message is only a warning and can be ignored. If you suspect the problem is due to the hotspot formatting 
bug RoboHELP provides a workaround solution.

Solution

If this message is because the WinHelp compiler applied hotspot formatting to a bullet or number, use 
RoboHELP's workaround:

1 From RoboHELP Explorer's Tools menu, select Options. The Options dialog appears.

2 Click the Compile tab.

3 Under RTF Output, select Remove Hotspot color from Bullets.

4 Click OK. 

5 RoboHELP prompts you that changing this option requires that all documents in the project are saved before 
the change is reflected in the compiled Help file:

· Click Yes for RoboHELP to automatically save all Help documents in the project.

· Click No if you prefer to save the documents at a later time. (The change won't be reflected in the compiled 
Help file until you open and save all affected documents in the Help project.)

Other possible solutions to get around the WinHelp compiler hotspot formatting bug:

· Change the hotspot, so it doesn't include first word.

· Try placing a space between the bullet or number character and the first word. (The space should be the first 
character.)

· If you know your users won't be using Windows NT, you could use the Wingdings font for the bullet character. 
However, if your end-users have Windows NT as their operating system, this can cause the bullet character to 
appear as another symbol – n, m, ?, or other symbol.



 HC4011: Warning: There are 20 opening braces without intervening closing 
braces

Problem 

More opening braces without matching closing braces have been encountered than should ever occur in a normal 
topic (.RTF) file.

Result 

The rest of the file is ignored.

Solution 

Try resaving the Help project and all Help documents. Then recompile. If the problem persists, contact Technical 
Support. 



 HC4012: Warning: The full-text search index cannot be created because 
neither Phrase nor Hall compression has been selected

Problem 

In order to create a full-text search index, you must compile with either Maximum or Hall compression.

Result 

The Help compiler is unable to generate an full-text search (.FTS) index file.

Solution 

Select either Maximum (Zeck and Hall) or Hall compression:

1 From RoboHELP Explorer's File menu, select Project Settings.
-or-
From Word's RoboHELP menu, select Project Settings.
The Project Settings dialog appears.

2 Click the Compile tab.

3 In Compression, select one of the following:

· Maximum

· Hall

· Zeck and Hall (same as the Maximum selection)

4 Click OK.

5 Recompile the Help file.



 HC4013: Warning: Invalid default font number in [ ]. Using [ ] as the default 
font

Problem 

The RTF token \deff specifies as a default font a font number that is not defined in the \fonttbl section.

Result 

The Help compiler will ignore the specification and use the first font declared in the \fonttbl section as the default 
font.

Solution 

In the topic (.RTF) file change the number after the \deff token to specify a font declared in the \fonttbl section. 
Then recompile.



 HC4014: Warning: There is text after the closing brace in the RTF file

Problem 

The Help compiler encountered the closing brace that should signify the end of the topic (.RTF) file and then 
encountered additional text.

Result 

The Help compiler adds the text to the Help file, but the text cannot be accessed.

Solution 

Close RoboHELP. In Windows Explorer, delete the .RTF file. Then reopen the project in RoboHELP and allow 
RoboHELP to regenerate the .RTF file. Recompile the Help file.



 HC5000: Error: The filename [ ] is too long

Problem 

The specified filename is too long.

Result 

The Help file is not created.

Solution 

Move or rename the folder or file. Then recompile the Help file.



 HC5001: Error: File is a folder, not a file

Problem 

You have specified a filename, but the name specified is actually a folder.

Result 

The Help file is not created.

Solution 

Move or rename the folder or the file and then recompile.



 HC5002: Error: The text for the button in the CreateButton macro is too long

Problem 

You have specified more than 96 characters in the CreateButton macro.

Result 

The Help file is not created.

Solution 

Reduce to 96 or less the number of characters in the CreateButton macro and then recompile.



 HC5003: Error: Permission to open the file [ ] is denied. Another program has 
probably locked the file

Problem 

You do not have the required file privileges to open the requested file. This can happen if the file has been opened 
by another program. For example, if WinHelp has the Help file open, The Help compiler is not be able to write to 
that Help file.

Result 

The Help file is not created.

Solution 

Try one or both of the following solutions:

· If the Help file is open in another program, switch to that application and either close the Help file or close the 
application. Try recompiling again.

· If you are trying to write to a file on a networked drive, make sure you have write-permission on that server.

· Verify the file is not Read Only.

· Set a valid TMP variable. Check the Project Settings: Advanced tab, Temp Directory field. If the folder 
listed isn’t valid, enter or navigate to a valid folder.



 HC5005: Error: The file [ ] cannot be found

Problem 

The specified file cannot be located.

Result 

The Help file is not created.

Solution 

Verify that you have specified the correct filename and that the file exists in the correct folder. Then recompile the 
project file.



 HC5006: Error: Invalid RTF tokens for a table

Problem 

A \row command appeared before a \cell command in the topic (.RTF) file.

Result 

The Help file is not created.

Solution 

Change the order of commands in the topic file and then recompile.



 HC5007: Invalid use of the WinHelp menu [ ] in the [ ] macro.

Problem 

You have attempted to use a standard WinHelp menu ID.

Result 

The Help file is not created.

Solution 

Use a menu ID created with a call to the ExtInsertItem, ExtInsertMenu, or InsertMenu macros.



 HC5009: Error: [ ] doesn’t contain a comma separating the parameters in the 
macro [ ]

Problem 

Either a parameter has been left out of the macro or parameters are not separated with a comma.

Result 

The Help file is not created.

Solution 

Add the missing comma or parameter to the macro in the topic file and then recompile.



 HC5010: Error: [ ] is an invalid parameter for the macro [ ]

Problem 

You cannot use a standard WinHelp menu as a parameter for this macro.

Result 

The Help file is not created.

Solution 

Use the name of your own custom menu.



 HC5011: Error: Cannot open the file [ ]

Problem 

The file cannot be opened. This can occur when another program has the file locked, or the file is on a network 
and the network is down.

Result 

The Help file is not created.

Solution 

If another program has the file open, close the file. In some cases, it may be necessary to close the program.



 HC5012: Error: Too many nested #include files. Cannot include the file [ ]

Problem 

A file specified in a #include statement can contain an included file which can in turn contain an included file, up to 
five levels. This limit has been exceeded.

Result 

The Help file is not created.

Solution 

Merge the contents of the deepest #include file into its parent and then recompile.



 HC5013: Error: Invalid DBCS escape sequence: [ ]

Problem 

The DBCS character is invalid.

Result 

The Help file is not created.

Solution 

If this is not a DBCS topic file, change the language of the Help file. Otherwise you will need to use a different 
word that doesn’t use this DBCS character.



 HC6000: Error: The Help compiler is out of memory. If you have any other 
programs running, close them and try compiling again

Problem 

There is insufficient memory and swap file space.

Result 

The Help file is not created.

Solution 

If you are running Windows 95, increase the amount of hard disk space available on the drive Windows is installed 
on. Otherwise, increase the size of your permanent swap file.



 HC6001: Error: Out of disk space writing to the temporary file [ ]. Free up disk 
space on this drive or change your TMP environment variable.

Problem 

There is insufficient space on the drive where the Help compiler is creating temporary files.

Result 

The Help file is not created.

Solution 

Either free space on the specified drive, or select another TMP folder:

1 From RoboHELP Explorer's File menu, select Project Settings.
-or-
From Word's RoboHELP menu, select Project Settings.
The Project Settings dialog appears.

2 Click the Advanced tab.

3 In Temp Directory, enter or navigate to the appropriate temporary folder.

4 Click OK.

5 Recompile the Help file.



 HC6002: Error: An error occurred while reading the file [ ]

Problem 

The Help compiler was not able to read the file. The file may be corrupt.

Result 

The Help file is not created.

Solution 

Confirm that the file is valid or replace it. If the file appears to be valid, run scandisk to verify that your hard disk 
doesn’t have problems.



 HC6003: Error: Out of file handles. Increase the FILES= line in CONFIG.SYS

Problem 

There are not enough file handles available.

Result 

The Help file is not created.

Solution 

If possible, increase the FILES= setting in the CONFIG.SYS file on your computer by 20, up to a maximum of 255. 
Reboot your computer and then recompile. If you still get this error message, increase by another 20 up to the 
maximum.



 HC6004: Error: The file [ ] is a read-only file

Problem 

The Help compiler cannot write to the specified file.

Result 

The Help file is not created.

Solution 

Change the file's read-only attribute if you want the Help compiler to overwrite the file. Otherwise, rename the file 
and recompile the project file.



 HC6005: Error: [ ] is a folder, not a file

Problem 

The name you have specified for a file is actually a folder.

Result 

The Help file is not created.

Solution 

Move or rename the folder or the Help file and then recompile.



 HC6006: Error: [ ] is a device name and cannot be used as a filename

Problem 

The name you have specified for a file is a device.

Result 

The Help file is not created.

Solution 

Change the name to a file, not a device and then recompile.



 HC6007: Error: Cannot write to the file [ ]

Problem 

An error occurred while the Help compiler was writing to a file.

Result 

The Help file is not created.

Solution 

Run scandisk to fix any problems on your hard drive. Or trying compiling on a different drive or network 
connection.



 HC6008: Error: No files have been specified in the [FILES] section of the 
project file

Problem 

The [FILES] section of your project file did not specify any files. Usually this occurs if the .HPJ file has been 
manually edited and all documents attached to this project have been deleted.

Result 

The Help file is not created.

Solution 

Import the Help document files into the Help project:

1 From RoboHELP Explorer's File menu, select Import Document.
-or-
From Word's RoboHELP menu, select Import Documentation.
The Import Document dialog appears.

2 Navigate to the Help document .DOC or .RTF file and click Open.

3 Click OK.

4 Repeat until all Help documents are added to the project.

5 Save and recompile the Help file.



 HC6009: Error: The language identifier [ ] is not supported in this version of 
Windows

Problem 

The language specified for the Help file is not supported on your version of Windows. 

Result 

The Help file is not created.

Solution 

Confirm that correct language has been specified. If the language is correct, you must compile the Help file on a 
version of Windows appropriate to that language. Contact Technical Support if you have questions.



 1019 Project file extension cannot be .HLP or .PH

Problem

You can’t specify a project file with an .HLP or .PH extension. Project files must use the .HPJ extension.

Solution

Rename the Help project file and then recompile.



 1030 File name exceeds limit of 259 characters

Problem

The combined length of the path and file name is more than the MS-DOS limit of 259 characters.

Solution

Shorten the path and then recompile.



 1079 Out of file handles

Problem

The Help Compiler doesn’t have enough available file handles to continue the build.

Solution
Close all unnecessary applications and try to compile the Help file again.

If this doesn’t work, you need to edit the FILES= line in your CONFIG.SYS file:

1 Open CONFIG.SYS located in the root folder of your hard drive.

2 In the FILES= line, increase the number by at least 10. (The recommended number on this line is between 80 
and 128. The maximum number allowed is 255.)

3 Save the changes to CONFIG.SYS and reboot your computer.

4 Open the Help project and compile again. 



 1100 Cannot open file filename permission denied

Problem

You don’t have the required file privileges to open the requested file.

Solution

Check with your system administrator or project manager to obtain the appropriate file permissions.



 1150 Cannot overwrite file filename

Problem

The Help file can’t overwrite the specified file because the file has a read-only attribute.

Solution

Rename the Help project file or change the read-only attribute.



 1170 File filename is a directory

Problem

A subdirectory in the Help project root directory has the same name as the requested Help file. This is an MS-DOS 
file error.

Solution

Move or rename the subdirectory and then recompile.



 1190 Cannot use reserved MS-DOS file filename

Problem

A file has been referred to by a reserved MS-DOS name such as COM1, LPT2, or PRN. This is a MS-DOS file 
error.

Solution

Rename the file that’s part of the Help project and then recompile.



 1230 File filename not found

Problem

The specified file could not be found or is unreadable. This is a MS-DOS file error or an out-of-memory condition.

Solution

Check to see if the file exists. Also check the amount of available memory.



 1292 File filename is not a valid bitmap

Problem

The specified bitmap file could not be found or is not in a recognizable bitmap format. This is a MS-DOS file error 
or an out-of-memory condition.

Solution

Check to see if the file exists, and if it does, check its format. If necessary, save the file again in your paint or draw 
program, and then recompile.



 1319 Disk full

Problem

There isn’t enough space on the destination disk, so the Help file couldn’t be written to disk.

Solution

Create more space on the destination disk and then recompile.



 1513 Bitmap name filename duplicated

Problem

The [BITMAPS] section contains duplicate bitmap names. The Help Compiler uses the first occurrence of the 
name.

Solution

Rename the duplicate bitmap file names and then recompile.



 1536 Not enough memory to check and compress bitmap filename

Problem

The specified bitmaps cannot be compressed because of insufficient memory. If any of the specified bitmaps are 
segmented hypergraphics, the context strings stored in them are not checked for validity during the build.

Solution

Use the protected mode version of the Help compiler (HCP.EXE).

To switch the Help compiler to HCP.EXE

1 From RoboHELP Explorer Tools menu, select Options.
-or-
From Word's RoboHELP menu, select Options.
The Options dialog appears.

2 Click the Advanced tab.

3 In Help Compiler, select HCP.

4 Click OK.

5 Recompile the Help project.



 2010 Include statements nested more than 5 deep

Problem

The #include statement on the specified line has exceeded the maximum of five include levels. 

Solution

Do not nest #include statements more than 5 deep.



 2030 Comment starting at line line number of file filename unclosed at end of 
file

Problem

The Help Compiler has unexpectedly come to the end of the Help project file. There may be an open comment in 
the .HPJ file or in an included file.

Solution

Try closing the project, then reopening it and compiling again. 



 2050 Invalid #include statement

Problem

There is an invalid #include statement.

Solution

Correct the syntax and then recompile. The correct #include syntax is as follows:

#include <filename>



 2091 Bracket missing from section heading section name

Problem

The right bracket ] is missing from the specified section heading.

Solution

Insert the bracket and then recompile.



 2111 Section heading missing

Problem

The section heading on the specified line is not complete. This error is also reported if the first entry in the Help 
project file is not a section heading

Solution

This usually only occurs if the HPJ file has been edited manually. Open the HPJ file in Notepad and correct the 
section heading.



 2131 Invalid OPTIONS syntax option=value' expected

Problem

The specified option uses invalid syntax.

Solution

Check the syntax of the options in the [OPTIONS] section and correct it.



 2141 Invalid ALIAS syntax context=context' expected

Problem

The specified Alias uses incorrect syntax.

Solution

Check the syntax of the entries in the [ALIAS] section of the HPJ. Or edit the Alias by right-clicking on it, selecting 
Properties, and making the appropriate changes.



 2151 Incomplete line in section name section

Problem

The entry on the specified line is incomplete. 

Result

The Help Compiler skips the line.



 2171 Unrecognized text

Problem

There is unrecognizable text following valid text. 

Result

The Help Compiler ignores the line.



 2191 Section heading section name unrecognized

Problem

A section heading that is not supported by the Help Compiler has been used. 

Result

The Help Compiler ignores the line.



 2214 Line in .HPJ file exceeds length limit of 2047 characters

Problem

HPJ file exceeds length limit of 2047 characters.    There is a line in the .HPJ file that exceeds the maximum length 
of 2047 characters.

Solution

Either edit the HPJ in Notepad and change the line length or simply open the Help project in RoboHELP. 



 2273 [OPTIONS] should precede [FILES] and [BITMAPS] for all options to take 
effect

Problem

Incorrect order in the HPJ file.

Solution

This happens only if the HPJ file has been manually edited. Make sure the sections are in the correct order. 

It is recommended that the [OPTIONS] section be the first section of the .HPJ file so that all the options will take 
effect. Also, if the ERRORLOG option is used, it should be the first line in the [OPTIONS] section.



 2291 Section section name previously defined

Problem

A duplicate section has been found in the Help project file. 

Result

The Help Compiler ignores the lines under the duplicated section and continues from the next valid section 
heading.

Solution

This happens only if the HPJ file was edited manually. Open the HPJ in Notepad and remove the duplicate 
section.



 2305 No valid files in [FILES] section

Problem

The file section is either empty or contains only invalid files.

Solution

Open the file in RoboHELP and import the Help documents. Save and recompile.



 2322 Context string context_name cannot be used as alias string

Problem

A context string that has been assigned an alias cannot be used later as an alias for another context string. That 
is, you cannot map a = b and then c = a in the [ALIAS] section.    The Help Compiler ignores the attempted 
reassignment on this line.

Solution

Edit the Alias:

1 From the RoboHELP Explorer Project tab, open the Project folder, and then open the Aliases folder.

2 Right-click on the alias you need to change and select Properties. The Alias Properties dialog appears.

3 In Topic, select the correct Topic ID – one that isn't already aliased.

4 Click OK to save your changes.

5 Save and recompile the Help file.



 2331 Context number already used in [MAP] section

Problem

The Map number on the specified line in the Help project file was previously mapped to a different Map ID. 

Result

The Help Compiler ignores the line.

Solution

Run the Duplicate Map IDs Report to verify the duplicates. Coordinate with your programming team to either 
remove the duplicate Map ID/Map number or use RoboHELP's Remove Unused Map IDs option to remove it 
yourself.



 2341 Invalid or missing context string

Problem

The specified line is missing a Map ID before an equal sign.

Solution

If the Map ID came from your programming team, coordinate with them to resolve this problem. If you're 
generating the Map ID through RoboHELP, delete the Map file and regenerate it by selecting Auto Generate Map 
IDs on the Document Properties dialog of the appropriate Help document. 



 2351 Invalid context identification number 

Problem

The Map number on the specified line is empty or contains invalid characters.

Solution

If the Map ID came from your programming team, coordinate with them to resolve this problem. If you're 
generating the Map ID through RoboHELP, delete the Map file and regenerate it by selecting Auto Generate Map 
IDs on the Document Properties dialog of the appropriate Help document. 



 2362 Context string context_name already assigned an alias

Problem

A Map ID can only have one alias. That is, you cannot map a = b and then a = c in the [ALIAS] section. The 
specified Map ID has already been assigned an alias in the [ALIAS] section. 

Result

The Help Compiler ignores the attempted reassignment on this line.

Solution

Edit the Alias:

1 From RoboHELP Explorer Project tab, open the Project folder, and then open the Aliases folder.

2 Right-click on the alias you need to change and select Properties. The Alias Properties dialog appears.

3 In Topic, select the correct Topic ID – one that isn't already aliased.

4 Click OK to save your changes.

5 Save and recompile the Help file.



 2372 Alias string alias name already assigned

Problem

You can't alias an alias. An alias cannot, in turn, be assigned another alias. That is, you cannot map a = b and then 
b = c in the [ALIAS] section. 

Result

The Help Compiler ignores the attempted reassignment on this line.

Solution

Edit the Alias:

1 From RoboHELP Explorer's Project tab, open the Project folder, and then open the Aliases folder.

2 Right-click on the alias you need to change and select Properties. The Alias Properties dialog appears.

3 In Topic, select the correct Topic ID – one that isn't already aliased.

4 Click OK to save your changes.

5 Save and recompile the Help file.



 2391 Limit of 6 window definitions exceeded

Problem

The maximum number of window definitions is one main window definition and five secondary window definitions.

Solution

Delete additional windows from the Help project:

1 From RoboHELP Explorer's File menu, select Project Settings. The Project Settings dialog appears.

2 Click the Windows tab.

3 Under Windows, select the window and click Delete.

4 Click OK to save the changes.

Note: If the window is referenced, you’ll need to remove all references first. For more information, refer to the 
RoboHELP Help file.

5 Recompile the Help file.



 2401 Window maximization state must be 0 or 1

Problem

The value of the fMax variable in the window attribute specification in the .HPJ file is something other than 0 or 1. 

Solution

Correct the entry and then recompile.



 2411 Invalid syntax in window color

Problem 

The syntax specified for the window’s color in the [WINDOWS] section of your project file is invalid.

Result 

The Help compiler ignores the window definition.

Solution 

Edit the window’s color definition:

1 From RoboHELP Explorer's Edit menu, select Windows. 

2 Under Displayed windows, clear all selections except for the window you need to edit. If you do, only the 
window you want appears in the window display area to the left.

3 Under Window Color, click Nonscroll or Client – depending on where the problem color is selected. The 
Color dialog appears.

4 Select a valid window color and click OK to exit the Color dialog. 

5 Click OK to save the changes.

6 Recompile the Help file.

Note: The correct syntax for the text and background color is (rrr, ggg, bbb).



 2421 Invalid window position

Problem

The window specified has an invalid position.

Result

The Help Compiler ignores this line, and the window does not have a predefined position.

Solution

Edit the window:

1 From RoboHELP Explorer's Edit menu, select Windows.

2 Under Displayed windows, clear all selections except for the window you need to edit. If you do, only the 
window you want appears in the window display area to the left.

3 Under Placement, adjust the top, left, width, or height of the window.

4 When you’re finished adjusting the size and location of the window, click OK.

5 Recompile the Help file.



 2431 Missing quote in window caption

Problem

The value of the caption attribute for the window definition in the .HPJ file is not enclosed in quotation marks. 

Result 

The Help compiler ignores the window definition. The window definition in the [WINDOWS] section is invalid.

Solution 

Edit the window:

1 From RoboHELP Explorer's Edit menu, select Windows. 

2 Under Displayed windows, clear all selections except for the window you need to edit. If you do, only the 
window you want appears in the window display area to the left.

3 In Window Title, delete the text and then enter the window's title (caption) again.

4 Click OK to save your changes.

5 Recompile the Help file.



 2441 Window name window name is too long

Problem

The window name exceeds the maximum length of 8 characters.

Solution 

Delete the window from the Help project. Then recreate the window, naming it with 8 characters or less. If the 
window is referenced anywhere in the project – in hotspots, macros, button commands, topics (as the default 
window), or the TOC, you’ll need to remove all references to the window before you can delete it.

To delete the window:

1 From RoboHELP Explorer's File menu, select Project Settings. The Project Settings dialog appears.

2 Click the Windows tab.

3 Under Windows, select the window and click Delete.

Note: If the window is referenced, you’ll need to remove all references first. Consult the RoboHELP Help 
system for instructions.

4 Click OK to save your changes.

5 Recompile the Help file.



 2451 Window position value out of range 01023

Problem 

One or more of the window position coordinates exceed the limit of 1023.

Result 

The Help compiler ignores the invalid window definition.

Solution 

Edit the window:

1 From RoboHELP Explorer's Edit menu, select Windows.

2 Under Displayed windows, clear all selections except for the window you need to edit. If you do, only the 
window you want appears in the window display area to the left.

3 Under Placement, adjust the top, left, width, or height of the window. 

4 Click OK to save your changes.

5 Recompile the Help file.



 2461 Window name missing

Problem

The window specification in the .HPJ file is missing the window name.

Solution

Create a window with the specified name:

1 From RoboHELP Explorer's File menu, select New > Window. The New Window dialog appears.

2 In Name, enter a name for the window – 8 characters or less.

3 In Title, enter the title for the window. This title is what the user sees at the top of the window whenever it 
displays.

4 In Template, select the template you want to base this window on.

5 Click OK to create the window.

6 If you need to modify the window’s properties, right-click on it and select Properties. 

7 Make the desired changes to the window’s buttons, size and location, and so on. Click OK when you’re done.

8 Save and recompile the Help file.



 2471 Invalid syntax in [WINDOWS] section 

Problem

The entry for a main or secondary window is incorrect. 

Result

The Help Compiler ignores the window entry. 

Solution

Check the window entry syntax and then recompile.



 2481 Secondary window position required

Problem

The X, Y, dX, and dY entries for the secondary window definitions must be specified in the .HPJ file.

Solution

Edit the secondary window and redefine the window’s position:

1 From RoboHELP Explorer's Edit menu, select Windows.

2 Under Displayed windows, clear all selections except for the window you need to edit. If you do, only the 
window you want appears in the window display area to the left.

3 Under Placement, adjust the top, left, width, or height of the window. 

4 Click OK to save your changes.

5 Recompile the Help file.



 2491 Duplicate window name window name

Problem

There are duplicate window names in the .HPJ file. 

Solution

Delete the duplicate windows:

1 From RoboHELP Explorer's File menu, select Project Settings. The Project Settings dialog appears.

2 Click the Windows tab.

3 Under Windows, select the duplicate window and click Delete.

4 Click OK to save your changes.

5 Recompile the Help file.



 2501 Window caption window caption exceeds limit of 50 characters

Problem

The caption for the window exceeds the limit of 50 characters.

Result 

The Help compiler ignores the window definition.

Solution 

Edit the window:

1 From RoboHELP Explorer's Edit menu, select Windows. 

2 Under Displayed windows, clear all selections except for the window you need to edit. If you do, only the 
window you want appears in the window display area to the left.

3 In Window Title, edit the title (window caption) and click OK.

4 Recompile the Help file.



 2511 Unrecognized option option name in [OPTIONS] section

Problem

An option has been used that is not supported by the compiler. 

Result

The Help Compiler skips this line.



 2532 Option option name previously defined

Problem

The specified option has been defined on a previous line. 

Result

The Help Compiler ignores the attempted redefinition.



 2550 Invalid path pathname in option name option

Problem

The Help Compiler cannot find the path specified by the ROOT option. 

Result

The Help Compiler uses the current working directory.



 2570 Path in option name option exceeds number of characters

Problem

The path specified by the ROOT option exceeds the MS-DOS maximum limit. 

Result

The Help Compiler ignores the path and uses the current working directory.



 2591 Invalid MAPFONTSIZE option

Problem

The font range syntax is invalid. 

Solution

The correct syntax is m[-n]:p.



 2612 Maximum of 5 font ranges exceeded

Problem

The maximum number of font ranges that can be specified is five. 

Result

The Help Compiler ignores any additional ranges.



 2632 Current font range overlaps previously defined range

Problem

A font size range overlaps a previously defined mapping. 

Result

The Help Compiler ignores the second mapping. 

Solution

Adjust one or both of the font ranges to remove any overlaps.



 2651 Font name exceeds limit of 20 characters

Problem

Font names cannot exceed 20 characters. 

Result

The Help Compiler ignores this line.

Solution

This is a nuisance warning that doesn’t affect the Help file at all. You can ignore this warning.



 2672 Unrecognized font name font name in FORCEFONT option

Problem

The Help Compiler has encountered a font name that it does not support. 

Result

The Help Compiler ignores the font name and uses the default Helvetica font.



 2691 Invalid MULTIKEY syntax

Problem

The Help Compiler does not recognize the syntax used in a MULTIKEY option. 

Solution

The valid syntax is MULTIKEY = char, where char is any capital letter other than "K."



 2711 Maximum of 5 keyword tables exceeded

Problem

The limit of five keyword tables has been exceeded. 

Result

The Help Compiler ignores the additional tables. 

Solution

Reduce the number of tables and then recompile.



 2732 Character already used

Problem

A character used for indicating the keyword table (MULTIKEY = char) was previously used. 

Result

The Help Compiler ignores the entry.

Solution

Remove the duplicate keyword.



 2752 Characters K' and k' cannot be used

Problem

These characters are reserved for Help's normal keyword table. 

Solution

Choose another character, and then recompile.



 2771 REPORT option must be ON' or OFF'

Problem

The REPORT option must be either True, 1, ON, YES, False, 0, OFF, or NO. 

Solution

Select a Report option:

1 From RoboHELP Explorer's File menu, select Project Settings.
-or-
From Word's RoboHELP menu, select Project Settings.
The Project Settings dialog appears.

2 Click the Compile tab.

3 In While compiling, display: Report (progress messages), either select or clear the check box.

4 Click OK.

5 Recompile the Help file.



 2811 OLDKEYHRASE option must be ON' or OFF'

Problem

The OLDKEYPHRASE option must be either True, 1, ON, YES, False, 0, OFF, or NO. 

Solution

Correct the entry and then recompile.



 2832 COMPRESS option must be OFF', MEDIUM', or HIGH'

Problem

The COMPRESS option must be either 1, YES, ON, True, HIGH, MEDIUM, 0, NO, OFF, or False. 

Solution

Select a compression option:

1 From RoboHELP Explorer's File menu, select Project Settings.
-or-
From Word's RoboHELP menu, select Project Settings.
The Project Settings dialog appears.

2 Click the Compile tab.

3 In Compression, select a compression option.

4 Click OK to save your changes.

5 Recompile the Help file.



 2842 OPTCDROM option must be TRUE' or FALSE'

Problem

The OPTCDROM option must be either True or False. 

Result

The Help Compiler defaults to False. 

Solution

Correct the entry and then recompile.



 2852 Invalid TITLE option

Problem

The TITLE option defines a string that is empty or contains more than 32 characters. 

Result

The Help Compiler truncates the title.

Solution

Shorten the Help project title:

1 From RoboHELP Explorer's File menu, select Project Settings.
-or-
From Word's RoboHELP menu, select Project Settings.
The Project Settings dialog appears.

2 Click the Project tab.

3 In Title, edit the text.

4 Click OK to save your changes.

5 Recompile the Help file.



 2872 Invalid LANGUAGE option

Problem

You have specified an ordering that is not supported by the compiler. 

Result

The Help Compiler defaults to U.S. sort ordering.



 2893 Warning option must be 1, 2, or 3

Problem

The warning reporting level can be set only to 1, 2, or 3. 

Result

The Help Compiler defaults to full reporting (level 3).



 2911 Invalid icon file filename

Problem

The Help Compiler cannot find the icon file specified in the ICON option, or the file is not a valid icon file.

Solution

Locate the missing file and recompile the Help file.



 2932 Copyright string exceeds limit of 50 characters

Problem

The maximum length of the copyright string in the About box is 50 characters. 

Result

The Help Compiler truncates the string.

Solution

Edit the copyright statement:

1 From RoboHELP Explorer's File menu, select Project Settings.
-or-
From Word's RoboHELP menu, select Project Settings.
The Project Settings dialog appears.

2 Click the Project tab.

3 In Copyright Notice, edit the text.

4 Click OK to save your changes.

5 Recompile the Help file.



 3011 Maximum of 32 build tags exceeded

Problem

The maximum number of build tags that can be defined is 32. 

Result

The Help Compiler ignores the additional tags.

Solution

Delete the additional build tags:

1 From RoboHELP Explorer's Project tab, open the Project folder, and then open the Build Tags folder.

2 Right-click on the additional build tag and click Delete. 

3 Repeat until you have 32 or less build tags defined.

4 Recompile the Help file.



 3031 Build tag length exceeds 32 characters

Problem

The build tag on the specified line exceeds the maximum of 32 characters. 

Result

The Help Compiler skips this entry.

Solution 

There are two ways to resolve this problem:

· Delete the build tag and re-add it with a shorter name.

· Specify topics to include or exclude from the build.

To delete a build tag and then re-add it:

1 From RoboHELP Explorer's Project tab, open the Project folder, and then open the Build Tags folder.

2 Right-click on the build tag and click Delete.

3 From the File menu, select New > Build Tag. The New Build Tags dialog appears.

4 In Build Tag, enter the name (32 characters or less) of the build tag.

5 Click OK.

6 Recompile the Help file.

To add a build tag to more than one topic at a time:

1 From RoboHELP Explorer's Topic List View, select the topics.

2 Right-click and select Build tags. The Build tags dialog appears.

3 Under Select Build Tags, select one or more build tags for these topics.

4 Click OK.

5 Save and recompile the Help project.



 3051 Build tag tag name contains invalid characters

Problem 

A build tag in the [BUILDTAGS] section contains something other than an alphanumeric character or the 
underscore (_) character.

Result 

The Help compiler ignores the line containing invalid characters.

Solution 

Edit the build tag (RoboHELP Explorer Project tab, Project folder, Build Tags folder) so that it contains only valid 
characters. Make any necessary changes in topics containing the specified build tag and then recompile. 



 3076 [BUILDTAGS] section missing
The BUILD option declared a conditional build, but there is no [BUILDTAGS] section in the Help project file.    The 
Help Compiler includes all topics in the build.

Problem 

A BUILD option was specified in the Help project file, but no [BUILDTAGS] section was specified.

Result 

The Help compiler includes all topics in the build.

Solution 

There are two solutions to this problem:

· Add a build tag to the project.

· Specify the topics to include or exclude by adding a build tag. 

To add a build tag to the Help project:

1 From RoboHELP Explorer's File menu, select New > Build Tag. The New Build Tag dialog appears.

2 In Build Tag, enter the name you want to give this build tag.

3 Recompile the Help file.

To add a build tag to more than one topic at a time:

1 From RoboHELP Explorer's Topic List View, select the topics.

2 Right-click and select Build tags. The Build tags dialog appears.

3 Under Select Build Tags, select one or more build tags for these topics.

4 Click OK.

5 Save and recompile the Help project.



 3096 Build expression too complex

Problem

The build expression has too many expressions ("~", "|" or "&") or is too deeply nested.

Result 

The Help compiler includes all topics in the build.

Solution 

Edit and simplify the build expression or remove it.

To edit a build expression:

1 From RoboHELP Explorer's File menu, select Project Settings.
-or-
From Word's RoboHELP menu, select Project Settings.
The Project Settings dialog appears.

2 Click the Advanced tab.

3 In Build Expression, simplify the build expression syntax.

4 Click OK.

5 Recompile the Help file.

To delete a build expression:

1 From RoboHELP Explorer's File menu, select Project Settings.
-or-
From Word's RoboHELP menu, select Project Settings.
The Project Settings dialog appears.

2 Click the Advanced tab.

3 In Build Expression, delete the text.

4 Click OK.

5 Recompile the Help file.



 3116 Invalid build expression

Problem

The syntax used on the specified line of the build expression contains one or more logical or syntax errors.

Result 

The Help compiler ignores the line with the invalid expression.

Solution 

Choose from two solutions:

· Add or edit the build expression for the Help project file.

· Add a build tag to the Help project.

To add or edit a build expression:

1 From RoboHELP Explorer's File menu, select Project Settings.
-or-
From Word's RoboHELP menu, select Project Settings.
The Project Settings dialog appears.

2 Click the Advanced tab.

3 In Build Expression, enter or edit the build expression. 

4 Click OK.

5 Recompile the Help file.

To add a build tag to the Help project:

1 From RoboHELP Explorer's File menu, select New > Build Tag. The New Build Tag dialog appears.

2 In Build Tag, enter the name you want to give this build tag.

3 Recompile the Help file.



 3133 Duplicate build tag in [BUILDTAGS] section

Problem

A build tag in the [BUILDTAGS] section has been repeated unnecessarily.

Result 

The Help compiler uses the first build tag and ignores the duplicate build tag.

Solution 

Remove (or rename) the duplicate build tags in the Help project file (RoboHELP Explorer Project tab, Project 
folder, Build Tags folder) and then recompile.



 3152 Build tag tag name not defined in [BUILDTAGS] section

Problem

The specified build tag has been assigned to a topic, but not declared in the Help project file. 

Result

The Help Compiler ignores the tag for the topic.

Solution

Ignore the warning or create the build tag.



 3178 Build expression missing from project file

Problem

The topics have build tags, but there is no BUILD = expression in the .HPJ file.    The Help Compiler includes all 
topics in the build.

Result

The Help Compiler recognizes that no build expression is defined. A message is issued so that you can include 
one, if so desired; but it’s not necessary to do so.

Solution

Ignore the warning or create a build expression.



 3511 Macro macro string exceeds limit of 254 characters
Problem

The macro string exceeds the maximum limit of 254 characters.

Solution 

Edit the macro using RoboHELP’s Macro Editor/Wizard or try deleting the macro and re-inserting it again.



 3532 Undefined function in macro name

Problem

The specified macro is not on the list of macros supported by the compiler, nor is it specified in the 
RegisterRoutine(). 

Result

The Help Compiler nonetheless passes the macro to the .HLP file.

Solution 

If this is a macro that calls a dynamic-link library (DLL) function, add the RegisterRoutine macro to the project file 
that defines this function name. Otherwise, you have probably misspelled the macro name. 



 3552 Undefined variable in macro name

Problem

The macro contains a variable that is not recognized by the compiler.

Solution

Edit the macro using RoboHELP’s Macro Editor/Wizard or try deleting the macro and re-inserting it again.



  3571 Wrong number of parameters to function in macro macro name

Problem

There are too many or too few parameters in the macro.

Solution

Edit the macro using RoboHELP’s Macro Editor/Wizard or try deleting the macro and re-inserting it again.



 3591 Syntax error in macro macro name

Problem

The syntax of the macro is invalid.

Solution

Edit the macro using RoboHELP’s Macro Editor/Wizard or try deleting the macro and re-inserting it again.



 3611 Function parameter type mismatch in macro macro name

Problem

There is a type mismatch (string or numeric) in the function call.

Solution

Edit the macro using RoboHELP’s Macro Editor/Wizard or try deleting the macro and re-inserting it again.



 3631 Bad macro prototype

Problem

The prototype string passed to RegisterRoutine is invalid.

Solution

Add the RegisterRoutine macro to the project file that defines this function name. Otherwise, you have probably 
misspelled the macro name. 



 3652 Empty macro string

Problem 

You started a hotspot with a ‘!’ character, but did not follow it with a macro.

Result 

The Help compiler ignores the macro call from the hotspot.

Solution 

Edit or redefine the macro hotspot using the Macro Editor/Wizard. Make certain that all text from the ‘!’ to the end 
of the macro is marked as hidden. Then recompile the Help project.



 4011 Context string context name already used

Problem

The specified context string was previously assigned to another topic. 

Result

The Help Compiler ignores the latter string, and the topic has no identifier.

Solution 

Resolve the duplicate context string:

1 Run the Duplicate Map IDs Report (RoboHELP Explorer Tools menu) to verify the duplicate context strings. 

2 Resolve the duplicates:

· If the Programmer provides the Map files and Map IDs, consult your Programmer to resolve this for you. 

· If the Help author provides the Map files and Map IDs, change the Map number on one of the duplicate Map 
IDs. 

3 Save the project and recompile.

Tip:

Use the Duplicate Map IDs Report or Diagnostics Report to help you identify the duplicate Map IDs 
(RoboHELP Explorer's Tools menu, Reports.)



 4031 Invalid context string context name

Problem

The context string footnote contains non-alphanumeric characters or is empty. 

Result

The Help Compiler does not assign the topic an identifier.

Solution

Consult with your programming team (if they supply the Map IDs) or re-generate the Map IDs for this document.



 4056 Unresolved context string specified in CONTENTS option

Problem

The Contents topic defined in the Help project file could not be found. 

Result

The Help Compiler uses the first topic in the build as the Contents.

Solution



 4072 context sting exceeds limit of 255 characters

Problem

The context string hidden text cannot exceed 255 characters. 

Result

The Help Compiler ignores the string.

Solution

If your programming team supplies the Map IDs, notify them to reduce the Map ID's context string. If you generate 
the Map IDs through RoboHELP, you'll need to reduce the size of the Map ID – modify the Topic ID by hand.



 4098 Context string(s) in [MAP] section are not defined in any topic

Problem 

The Help compiler cannot find the specified Topic IDs listed in the [MAP] section of the project (.HPJ) file.

Result 

The Help compiler ignores the lines in the project file. If the program uses that number in the WinHelp function, 
WinHelp displays the "Help topic not found" error message.

Solution 

Verify that all Topic IDs listed in the [MAP] section of the project file are assigned to topics included in the build and 
that the Topic IDs are spelled correctly. Then Recompile the Help file.



 4113 Unresolved jump or pop-up to context name

Problem 

The specified topic contains a context string that identifies a nonexistent topic. 

Result 

WinHelp displays the "Topic not found" error message when the user chooses a hotspot with the unresolved Topic 
ID.

Solution 

Usually this warning occurs when there are broken links in the Help project. Even a punctuation mark – like a 
comma or period – that accidentally gets included in the hidden text part of the hotspot can create a broken link. 
Check the Broken Links folder to resolve the problem.

To check the Broken Links folder:

1 From RoboHELP Explorer's Project tab, open the Topics folder, and then open the Broken Links folder.

2 Right-click on the broken link and select Resolve Broken Links. The Resolve Broken Links dialog appears. 
Select the option you want to use to resolve the broken link. If there’s a spelling error (such as included 
punctuation in the hidden text area), the Edit option usually helps you quickly resolve the problem. 

3 Save and recompile the Help project.



 4131 Hash conflict between context name and context name

Problem

The hash algorithm has generated the same hash value for both of the listed context strings. 

Result 

WinHelp displays the topic with the first Topic ID whenever the user chooses a hotspot containing either Topic ID.

Solution 

Change one of the specified Topic IDs and then recompile.



 4151 Invalid secondary window name window name

Problem

The window name for the secondary window is "main" or another disallowed member name.

Solution

Delete the window and recreate it. 

To delete the window:

1 From RoboHELP Explorer’s Project tab, open the Project folder, and then open the Windows folder.

2 Right-click on the window to delete and click Delete.

Note: If the window is referenced, you’ll need to remove all references first. Consult the RoboHELP Help 
system for instructions.

3 Click OK. The window is now deleted.

To recreate the window:

1 From RoboHELP Explorer's File menu, select New > Window. The New Window dialog appears.

2 In Name, enter a name for the window – 8 characters or less.

3 In Title, enter the title for the window (caption). This title is what the user sees at the top of the window 
whenever it displays.

4 In Template, select the template you want to base this window on.

5 Click OK to create the window.

6 If you need to modify the window’s properties, right-click on it and select Properties. 

7 Make the desired changes to the window’s buttons, size and location, and so on. Click OK when you’re done.

8 Save and recompile the Help file.



 4171 Cannot use secondary window with pop-up

Problem 

The hidden text defining the pop-up identifier contains a secondary window name.

Result 

The hotspot is not active in the Help file.

Solution 

Remove the right angle bracket and secondary window name from the pop-up hotspot, or change the single 
underline to double underline (for a topic jump). Then recompile the Help file.



 4196 Jumps and lookups not verified
Problem

Due to the low memory conditions, the build is continued without the jump and keyword validity verification.

Solution

Free some memory on your system and recompile. Sometimes, closing other applications works. Or consult your 
Windows Help system for more information.



 4211 Footnote text exceeds limit of 1023 characters

Problem

The footnote text cannot exceed the limit of 1023 characters. 

Result

The Help Compiler ignores the footnote.

Solution 

Reduce the length of the footnote text in the topic file and then recompile. For some footnotes, such as the K 
(Index keywords) footnote, you can use several smaller footnotes instead of one larger footnote.



 4231 Footnote text missing

Problem

The specified topic contains a footnote that has no characters.

Solution



 4251 Browse sequence not in first paragraph

Problem

The browse-sequence footnote is not in the first paragraph of the topic. In most cases, this is due to a missing 
page break between Help topics.

Result

The Help Compiler ignores the browse sequence.

Solution 

Find where the topics should be split (look for the footnotes and topic title) and add a page break at the beginning 
of the line. Save and recompile the Help project.



 4272 Empty browse sequence string

Problem

The browse-sequence footnote for the specified topic contains no sequence characters.

Solution

Edit the browse sequence for the specified topic.

Open the Browse Sequence Editor and edit the specified topic. 
-or-

1 Right-click on the topic and select Properties. The Topic Properties dialog appears. 

2 Select the Advanced tab and edit the Browse Sequence Name or Browse Sequence Number fields. 

3 Click OK to save your changes. 



 4292 Missing sequence number

Problem

A browse-sequence number ends in a colon (:) for the specified topic. 

Solution

Remove the colon, or enter a "minor" sequence number and then recompile.



 4312 Browse sequence already defined

Problem 

The browse sequence footnote (+) has been specified twice in the same topic. In most cases, this is due to a 
missing page break between Help topics.

Result 

The Help compiler uses the first browse sequence footnote and ignores the duplicate footnote.

Solution 

Find where the topics should be split (look for the footnotes and topic title) and add a page break at the beginning 
of the line. Save and recompile the Help project. 



 4331 Title not in first paragraph

Problem

The title footnote ($) is not in the first paragraph of the topic. 

Result

The topic will not have a topic title string.

Solution

Edit the topic's properties and make sure a title appears on the Topic Properties: General tab. Re-create the 
topic, if necessary



 4352 Empty title string

Problem 

The title footnote doesn’t precede the first paragraph of the topic. In most cases, this is due to a missing page 
break between Help topics.

Result 

The Help compiler ignores the title footnote, and the topic doesn’t have any title.

Solution 

Find where the topics should be split (look for the footnotes and topic title) and add a page break at the beginning 
of the line. Save and recompile the Help project.



 4372 Title defined more than once

Problem 

A title footnote has already been specified for the topic. In most cases, this is due to a missing page break 
between Help topics.

Result 

The Help compiler uses the first title footnote and ignores the duplicate title footnote.

Solution 

Find where the topics should be split (look for the footnotes and topic title) and add a page break at the beginning 
of the line. Save and recompile the Help project.



 4393 Title exceeds limit of 128 characters

Problem

The title for the specified topic exceeds the limit of 128 characters. 

Result

The Help Compiler ignores the additional characters.

Solution

Edit the topic title and shorten the title:

1 From RoboHELP Explorer's, right-click on the topic and select Properties.
-or-
From Word, right-click anywhere in the topic and select Topic Properties.
The Topic Properties dialog appears.

2 Click the General tab.

3 In Title, shorten the length of the title.

4 Click OK.

5 Save and recompile the Help file.



 4412 Keyword string exceeds limit of 255 characters

Problem 

Keywords can only be 255 characters. A keyword in the Help project exceeds this limit. 

Result 

The Help compiler ignores the keyword.

Solution 

Shorten the keyword or check the keyword at the topic level on the Topic Properties: Index tab or in the topic 
footnotes for a missing semicolon. (Multiple keywords for a topic must be separated by a semicolon in the topic 
footnotes.)    Once you’ve corrected the problem, recompile the Help project.



 4433 Empty keyword string

Problem

There is a keyword footnote (K), but there are no keywords listed for this topic. (There are no characters in the 
keyword footnote in the topic (.RTF) files.)

Result

The Help compiler ignores the keyword footnote. If there are no additional keyword footnotes, the topic will be 
inaccessible from the Index tab in the Help Topics dialog box.

Solution

Add one or more keywords to the topic and then recompile.



 4452 Keyword(s) defined without title

Problem 

One or more keywords have been specified for the topic, but a title footnote was not specified.

Result 

If no title is specified for the topic, and the keyword appears in more than one topic (including other Help files), 
WinHelp will display “Untitled topic #n” in the Topics Found dialog box.

Solution 

For standard topics – add a title:

1 From RoboHELP Explorer, right-click on the topic and select Properties.
-or-
From Word, right-click anywhere in the topic and select Topic Properties.
The Topic Properties dialog appears.

2 Click the General tab.

3 In Title, enter the title for the topic.

4 Click OK.

5 Save and recompile the Help file.

For popup topics – remove the keyword:

1 From RoboHELP Explorer, right-click on the topic and select Properties.
-or-
From Word, right-click anywhere in the topic and select Topic Properties.
The Topic Properties dialog appears.

2 Click the Index tab.

3 Remove all keywords.

4 Click OK.

5 Save and recompile the Help project.



 4471 Build tag footnote not at beginning of topic

Problem 

The build footnote doesn’t precede all other text and footnotes in the topic. In most cases, this is due to a missing 
page break between Help topics.

Result 

The Help compiler ignores the build tag footnote, and the topic is not assigned a build tag.

Solution 

Find where the topics should be split (look for the footnotes and topic title) and add a page break at the beginning 
of the line. Save and recompile the Help project.



 4492 Build tag exceeds limit of 32 characters

Problem 

The build tag is too long when used in conjunction with the BUILD option in the project file.

Result 

The Help compiler ignores the build tag assigned to the topic.

Solution 

There are two ways to resolve this problem:

· Delete the build tag and re-add it with a shorter name.

· Specify topics to include or exclude from the build.

To delete a build tag and then re-add it:

1 From RoboHELP Explorer's Project tab, open the Project folder, and then open the Build Tags folder.

2 Right-click on the build tag and click Delete.

3 From the File menu, select New > Build Tag. The New Build Tags dialog appears.

4 In Build Tag, enter the name (32 characters or less) of the build tag.

5 Click OK.

6 Recompile the Help file.

To add a build tag to more than one topic at a time:

1 From RoboHELP Explorer's Topic List View, select the topics.

2 Right-click and select Build tags. The Build tags dialog appears.

3 Under Select Build Tags, select one or more build tags for these topics.

4 Click OK.

5 Save and recompile the Help project.



 4551 Entry macro not in first paragraph

Problem 

The entry macro footnote was specified after text was specified for the topic. In most cases, this is due to a 
missing page break between Help topics.

Result 

The Help compiler ignores the entry macro footnote.

Solution 

Find where the topics should be split (look for the footnotes and topic title) and add a page break at the beginning 
of the line. Save and recompile the Help project.



 4616 File filename is not a valid RTF topic file

Problem

The specified file is not in .RTF file format.

Result 

The Help compiler ignores the file.

Solution 

Use the Save As RTF to save the document and recompile. If you still get this warning, make sure the 
RoboHELP.DOT template is attached to the document or use the Import Documentation or Convert Document 
option to turn the DOC file into a Help document.



 4639 Error in file filename at byte offset 0x%IX)

Problem 

The Help compiler encountered an error while processing the topic (.RTF) file. The specified file contains 
unrecognized RTF at that byte offset. This problem can occur when the number of opening and closing braces 
don’t match, when the end of the file is reached before all columns of a table have been specified, or when the 
number specified for an RTF token is invalid.

Result 

The Help compiler ignores the rest of the topic file.

Solution 

Open the file and save it again as Rich Text Format (RTF) and then recompile. If the problem persists, look for 
errors in the topic file.

This message should not appear if you are using Microsoft Word for Windows, Microsoft Word for MS-DOS, or 
Microsoft Word for the Macintosh.. Check the RTF syntax and then recompile. If you are using Microsoft Word for 
the Macintosh, transfer the file to the PC again, and then recompile.



 4649 File filename contains more than 32767 topics

Problem

The maximum number of topics allowed in one .RTF file (one Help document) is 32,767. 

Solution

Create a new Help document and cut and paste topics between the two documents to reduce the number of topics 
in the larger .RTF file.

Note: RoboHELP recommends keeping your DOC files to 200 topics or less, but remember that DOC files are just 
a way to organize and manage topics. Create as many Help documents as you need to suit your needs.



 4652 Table formatting too complex

Problem 

A table format has been specified that WinHelp doesn’t support.

Result 

The Help compiler ignores the borders on the table. 

Solution 

You have three options:

· Ignore the note. The appearance of the Help text isn’t affected.

· Remove the unsupported formatting (borders, shading, or right justification) from the table and recompile.

· Create a bitmap from the table. If the table fits on the screen, do a screen shot and save it as a bitmap. Insert 
the table bitmap into the topic and recompile.



 4662 Side-by-side paragraph formatting not supported

Problem 

Side-by-side paragraph formatting has been used.

Result 

The Help compiler ignores the side-by-side paragraph formatting.

Solution 

Convert the side-by-side paragraphs to a table or a tabbed paragraph and recompile.



 4671 Table contains more than 32 columns

Problem 

The table has more columns than WinHelp is able to display. (The maximum number of columns in one table is 32. 
Some word processors may have different limits for the number of columns supported.)

Result 

The Help compiler treats the additional columns as one table cell.

Solution 

Reduce the number of table columns and then recompile.



 4680 Font font name in file filename not in RTF font table

Problem 

A font not defined in the RTF header has been entered into the topic. 

Result 

The Help compiler ignores the font name and uses the default MS Sans Serif font.

Solution 

Change the font name in the project file to a supported font and then recompile. Alternatively, remove the font 
ranges and instead use the font substitution in the Fonts tab of the Options dialog box in The Help compiler.



 4692 Unrecognized graphic format

Problem 

An embedded bitmap contains a format that the Help compiler doesn’t recognize. The Help compiler supports only 
Windows bitmaps (.BMP) and Windows metafiles (.WMF). Make sure that you have not used Macintosh picture 
formats.

Result 

The Help compiler ignores the specified graphic.

Solution 

Convert the graphic and recompile. You can either do a screen shot of the graphic and use RoboHELP’s Paste as 
Help Image or use RoboHELP’s Import feature on the Insert Help Image dialog. 



 4733 Hidden page break

Problem 

A page break has been formatted as hidden text.

Result 

The Help compiler ignores the page break. If the page break was used to separate two topics, the topics appear 
as one topic.

Solution 

Reformat the page break in the topic file as plain text and then recompile.



 4753 Hidden paragraph

Problem 

A paragraph mark has been formatted as hidden text. This often occurs when a hotspot is the last word in a 
paragraph.

Result 

The Help compiler ignores the paragraph mark, so the two paragraphs will run together.

Solution 

Reformat the paragraph marker as plain text in the topic file and then recompile.



 4763 Hidden carriage return

Problem 

A carriage return has been formatted as hidden text.

Result 

The Help compiler ignores the carriage return and doesn’t create a new line.

Solution 

Reformat the carriage return in the topic file as plain text and then recompile.



 4774 Paragraph exceeds limit of 64K

Problem

A single paragraph has more than 64K of text or 64K of graphics.

Solution

Locate the problem paragraph or graphic and reduce its size. 



 4792 Nonscrolling region defined after scrolling region

Problem 

The Keep With Next attribute was applied to a paragraph after a paragraph that did not have this attribute.

Result 

The Help compiler ignores the Keep With Next attribute; the paragraph is treated as plain text and is displayed as 
part of the topic text displayed in the scrolling region of the topic.

Solution 

Find the text that has the Keep With Next option (marked as a non-scrolling region) and turn off the option.



 4813 Nonscrolling region crosses page boundary

Problem 

The Keep With Next paragraph formatting used for specifying a non-scrolling region crosses a page break 
boundary.

Result 

The topic beginning with the page break will have a non-scrolling region, whether or not one is intended.

Solution 

Select the entire topic – including the page break for the next topic – and remove the Keep With Next paragraph 
formatting. If you intended to have a non-scrolling region for the topic, select only the topic title, and from the 
RoboHELP menu select Set Non-Scrolling Region. Recompile the Help file.



 5035 File filename not created

Problem 

Either there are no topics to compile or there are no topics with the build expression specified. The Help compiler 
reached the end of all topic files without encountering any text.

Result 

The Help compiler doesn’t create a Help file.

Solution 

Confirm that you have specified at least one Help document file that contains topics with text. If all topics contain 
build tags, you must specify at least one build expression to include on the Project Settings: Advanced tab. 
Correct any errors and recompile the Help file.



 5059 Not enough memory to build Help file

Problem 

There is insufficient memory and swap file space.

Result 

The Help file is not created.

Solution 

Choose one or more of the following solutions:

· If you are running Windows 95, increase the amount of hard disk space available on the drive Windows is 
installed on. Otherwise, increase the size of your permanent swap file.

· To free up memory, unload any unneeded applications, device drivers, and memory-resident programs. 

· If you have large pictures embedded in your project (the pictures were copied in from the clipboard or other 
area), convert these to Help images and compile again. 

· If you are using HC31.EXE or HC30.EXE, you may not have enough memory to compile the project.    For 
HC30.EXE, try compiling from a DOS prompt or consider converting to a 3.1 compatible project and compiling 
with HCP.EXE.

· Try choosing the protected mode version of the help compiler, HCP.EXE (Project Settings: Advanced tab).



 5075 Help Compiler corrupted. Please reinstall HC31.EXE.

Problem

The virus checking code has detected a corruption in the Help Compiler. 

Solution

Reinstall HC31.EXE or contact Blue Sky Technical Support for assistance.



    5098 Using old key-phrase table

Problem

The Help compiler found an existing phrase (.PH) table for the Help file you are building, and the project (.HPJ) file 
doesn’t specify not to use the table.

Result

The Help compiler uses the phrase table that was generated from an earlier build instead of creating a new table.

Solution

To achieve the best phrase compression when compiling your Help file, you must delete the old key-phrase table:

1 From RoboHELP Explorer's File menu, select Project Settings.
-or-
From Word's RoboHELP menu, select Project Settings.
The Project Settings dialog appears.

2 Click the Compile tab. 

3 Under Compression, clear the Reuse Phrase File (faster) option. (This option is only available if either the 
Phrase or Zeck and Phrase compression options are selected.)

4 Click OK.



 5115 Write failed

Problem 

An error occurred while the Help compiler was writing to a file.

Result 

The Help file is not created.

Solution 

Run scandisk to fix any problems on your hard drive. Or trying compiling on a different drive or network 
connection.



 9001: Unrecognized footnote code

Problem

The Quick Checker encountered an unrecognized footnote code.

Solution

Try recompiling the project again. If the error reoccurs and you've added a custom footnote, remove the custom 
footnote. If the error reoccurs and you haven't added a custom footnote, check your footnotes or contact Technical 
Support.



    9002: Embedded object text too long

Problem

The Quick Checker encountered an embedded object whose definition text exceeds the amount available. 

Result

The embedded object is ignored by the Quick Checker.



  9003: Hotspot text too long

Problem

The Quick Checker encountered a jump, macro, or popup hotspot that has a text string longer than the allowed 
amount. 

Result

The hotspot is ignored by the Quick Checker.

Solution

Edit or remove the hotspot.



 9004: Invisible text too long

Problem 

The Quick Checker encountered a jump, macro, or popup hotspot whose invisible text exceeds the length allowed 
by the Quick Checker.

Result

The hotspot definition is ignored by the Quick Checker.

Solution

Edit or remove the hotspot.



 9005: Hotspot text crosses paragraph boundary

Problem

The Quick Checker has encountered a jump, macro, or popup hotspot whose hotspot text contains a paragraph 
marker. 

Result

The text to the right of the paragraph marker is ignored by the Help Compiler.

Solution

Edit the hotspot and remove the paragraph marker or remove the hotspot.
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